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1 Introduction 

Introduction 

This manual is designed to help beginners get started with their Ethiris systems.  

There are a total of six different manuals for Ethiris. Besides this one, there are 
also Installing Ethiris, Admin - Configuration for Ethiris, Ethiris Client User´s 
Guide, Integration with Ethiris, and Getting started with Ethiris Mobile. 

This part of the manual suite describes the basic setup of an Ethiris system, 
assuming that Ethiris is already installed on the computer. For information on 
how to install Ethiris, please refer to the Installation manual. For in-depth 
information on the various functions in Ethiris, please see the Admin - 
Configuration for Ethiris manual and the Ethiris Client User´s Guide manual. 

Use 

The primary purpose of Ethiris is camera surveillance, which is performed in 
two ways. One way is manually to monitor live video from different cameras. 
The other way involves recording video from connected cameras. Recording can 
take place continuously from one or more cameras or in the form of video 
sequences when a recording condition is met. The recorded video can be 
played back afterward using sophisticated timelines and a VCR-like interface. 

General Description 

Ethiris is a surveillance system that uses network cameras and analog cameras, 
together with video encoders from different suppliers. The product is divided 
into several program parts, where Ethiris Server and Ethiris Client are the most 
important ones. The server part manages all cameras and stores video on the 
hard disk. The client part displays live video and recorded video sequences. 

There is also a program called Ethiris Admin, which is used for configuring all 
Ethiris modules in the system. In Ethiris Admin you configure the Ethiris Servers 
by, e.g., defining which cameras are connected to each Ethiris Server, when 
video shall be recorded, what frame rate and resolution to use, etc. You also 
define the view layout in the various Ethiris Clients in the system using Ethiris 
Admin. 

In theory, an unlimited number of cameras could be connected to each Ethiris 
server and be displayed in the desired number of Ethiris clients simultaneously. 
In practice, however, bandwidth and monitor resolution set limits for the 
appropriate number of cameras connected.  
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There are different license levels for Ethiris, which permit different numbers of 
cameras to be connected. To meet the need for a large number of cameras, 
Ethiris is designed with a focus on scalability. Scalability means that it is possible 
to divide your system into several Ethiris servers and thus distribute the load 
over several computers.   

 

Ethiris Server 

Ethiris Server is the core of an Ethiris system. It handles all communication with 
the cameras and recording of video on a hard disk. Ethiris Server runs as a 
service under the operating system and is automatically started as soon as the 
computer is started. An Ethiris system can be comprised of one or several 
Ethiris Servers. 

 

 

Ethiris Client 

Ethiris Client is used for viewing live video and recorded video. An Ethiris Client 
can connect to one or several Ethiris Servers for access to cameras. An Ethiris 
system can contain one or several Ethiris Clients. 

 

 

Ethiris Admin 

Ethiris Admin is used for configuring the different parts in an Ethiris system. 
Ethiris Server and Ethiris Client are configured with this common tool. From any 
computer in the system, Ethiris Admin can be run and used for configuring all 
Ethiris components on-site. 

 

 

Ethiris Mobile 

Ethiris Mobile is an app for connecting to your Ethiris systems via your cell. 
With Ethiris Mobile you can watch live video from various cameras in your 
system. You can also see all the alarms.  

 

 

Ethiris Server OPC Server 

Ethiris Server OPC Server is a separate Ethiris component that is used for letting 
other systems gain access to the information in Ethiris Server. Any other system 
with an OPC client can connect to one or several Ethiris Servers and read/write 
to all signals in Ethiris Server. E g starting recording of a camera or control a PTZ 
camera.  

 

 

Ethiris ActiveX 

Ethiris ActiveX is a component used for viewing live video from a camera 
connected to an Ethiris Server. This component can be used in any system that 
can handle standard ActiveX components. 

 

 

Ethiris Viewer 

Ethiris Viewer is a separate program used for viewing exported video from an 
Ethiris system. 

 

 

Ethiris Signature Validator 

Ethiris Signature Validator is a separate software that is used to validate the 
authenticity of exported jpg images, so-called watermark. 
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2 Getting Started 

Overview 

In the following section, you will learn how to start using Ethiris through a 
guided tour. 

This tour will alternate between the server and client parts. A functioning 
system is based on at least one server and at least one client. Step by step, we 
will configure a complete system. 

The section is divided into various tasks. The first tasks are simple systems. We 
will gradually add more and more functions so that, when all the tasks have 
been completed, we will have looked at the vast majority of the functions in 
Ethiris. This is all so that we can cover as many different requirements as 
possible.  

After the tour, you will: 

 Understand the fundamental objects in Ethiris 

 Be able to configure both small and large systems 

 Have an idea of the various client views in Ethiris 

 Be able to configure the user interface in Ethiris 

 Be able to use the most common functions in Ethiris 

Before we start in on the tasks, we need to explain how the licensing of Ethiris 
works. 

Ethiris License 

Temporary License 

When you install Ethiris Server on a computer, the installation program sets up 
a temporary license. This means that Ethiris Server works normally, but for a 
limited time (15 minutes) from when the system is started. When this time has 
expired, Ethiris Server will cease to communicate with the cameras connected. 
However, any simulator cameras connected will continue to work without 
interruption. Restart the computer to get a new test period. 

When an Ethiris Server runs under a temporary license, all video retrieved from 
it and displayed in Ethiris Client will also be marked with “License missing”. 

To obtain a license that allows Ethiris Server to work fully, you have to use 
Kentima License Handler to generate a registration key and send it to Kentima 
AB. See the following section for how this is done. 
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Registration 

Registration has to 
take place at the computer 
where the server is running 

Before Kentima AB can issue a license code for a system, the customer must – 
after installing Ethiris Server – create a registration code from the installed 
Ethiris Server program and send it to Kentima AB. This procedure is managed 
by the tool Kentima License Handler. Note that all operations required for 
licensing must be performed locally on the computer that is being licensed. 

The registration code that is created by Kentima License Handler is unique to 
the computer where it was created, and the license code that Kentima AB will 
create is based on this registration code and will, therefore only function on this 
computer. 

Note! Remember to disable virtual network cards such as VPN clients, 
Bluetooth, or WiFi before generating the registration code. Otherwise, there 
may be a license problem later on if Ethiris Server does not find the virtual 
network card.  

The license handler is a guide with a few simple steps to facilitate the 
registration of an Ethiris

 
product: 

1. This is the first step of the license guide. Select Ethiris - Server (or 
other Kentima product to license). 

 
Figure 2.1 First step in the license guide. 

Select the product to license and then click Next> to continue the licensing 
procedure. 

2. The next step is to send the registration code to Kentima AB. The 
best alternative is to log on to Kentima Partner pages on the 
Internet at www.kentima.se and paste the registration code into 
the license page and retrieve a license code directly. 

Other alternatives are the ones shown in Figure 2.2 . If you choose 
the option, By e-mail, a new e-mail will be created automatically 
containing the necessary information when you click on Send. All 
you have to do is fill in the user and company information before 
you send it. In the same fashion, a letter (Notepad document) is 
created if you choose By letter, where you just have to fill in user 
and company information, print and send it or save the text file 
and attach it to an email.  
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The last alternative is simply to copy the Registration code from 
the dialog and then paste it into an email for sending it to 
license@ethiris.com.   
 
 

 
Figure 2.2 In this step, you send the registration code to Kentima. 

When you have sent the registration code to Kentima, click Next. 

3. In this step, you enter the license key that you obtain from 
Kentima. Since you have not yet received any license key you can 
click Cancel and return to this step at a later time. 
 

 
Figure 2.3 Enter the license code you received from Kentima. 

When you have received your license key from Kentima, you can return to this 
step, enter the license key in the designated box and click Next to continue to 
the next step. The license handler will automatically take you to the correct 
step if you start it again. 
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4. This step shows that the registration has succeeded and displays 
the license information.  
 

 
Figure 2.4 This step confirms that the licensing procedure is completed. 

After checking the license information is correct, click Finish to close the guide. 

The next time you open the license handler and selects the same product, the 
following dialog is displayed. 

 
Figure 2.5 This dialog is displayed if you open the license guide again. 

After having entered the license code, please restart the computer to restart 
the Ethiris Server and discover the new license code. 



Getting started with Ethiris Getting Started 

 Ethiris License  

 2:5  

Unregister the license 

The most common reason for unregistering the license is that you are moving 
the software from one computer to another. To verify that you have removed 
the license from the original computer you get a unique unregistration code 
that you can send to Kentima.  

If you want to unregister a license, start the license handler, and go through 
these simple steps:  

1. The first step is to indicate that you want to unregister the license. 
 

 
Figure 2.6 Here, you can choose to unregister the license. 

Check the radio button Unregister license. Now you can click Next to continue. 

You will get a warning dialog to make sure you do not unregister the license by 
mistake.  

 
Figure 2.7 The Warning dialog is displayed to avoid unregistering by mistake. 
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In this case, when you want to unregister, click Yes. 

Here we can see that the license is unregistered. You must also send the 
unregistration code to Kentima.  
 

 
Figure 2.8 The license has been unregistered, and an unregistration code has been 
generated. 

After sending the unregistration code to Kentima, click Next. 

If the purpose of the unregistration was to move the software to another 
computer, it’s a good idea to send the registration code from the new computer 
and the unregistration code from the old computer together in the same e-
mail/letter. 

Send the code to Kentima AB by e-mail or post. Don’t forget to specify the 
return address and any request for another license level than the current one.  

 

Upgrade the license 

If you need to upgrade an active license, you can – after agreement with your 
Ethiris-supplier – take out a new registration code from Ethiris and send it to 
Kentima to get a new license code containing a different license level or other 
options. 

1. Start Kentima License Handler from the Start-menu and select the 
Ethiris product you wish to upgrade and click Next. 
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Figure 2.9 Select product to upgrade. 

2. Select Upgrade license and then click Next to generate a new 
registration code and send it to Kentima, and you will receive a 
new license code with a different level and/or options. 

 
Figure 2.10 Select ”Upgrade license” to upgrade. 

 

3. Don’t forget to fill in contact information in the letter/e-mail that 
you send to Kentima if there are any questions.  
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Figure 2.11 Select ”By e-mail” or ”By Letter” to send in the registration code. 

4. When you have sent the code to Kentima, you can close the license 
handler by clicking Cancel. When the new license code arrives, it 
can be entered into the system in the precise same way as during 
a new installation. See the description above. 

 

Address 

You can send registration codes or unregistration codes for Ethiris Server in any 
of the following ways: 

 Internet – Go to http://www.kentima.com and log on to the 
Kentima partner pages. 

 E-mail – Fill in your company information in the license handler 
dialog and send the e-mail message to license@ethiris.com (pre-
set in the e-mail) 

 Mail - Fill in your company information in the license handler 
dialog, print the letter and post it to: 
Kentima AB 
Box 174 
245 22 Staffanstorp 
SWEDEN 
 
Mark the envelope: ”Ethiris License” 

 

For the fastest response register on the internet, this gives the possibility for 
automatic handling, the other methods require manual involvement and will 
take a little bit longer to handle. 
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License levels 

For the moment, there are five license levels in Ethiris. The difference lies 
mainly in how large of a system that can be built. 

 

 

Free 

The entry-level is free of charge and is intended to be used by anyone who 
wants to try out Ethiris. You can connect up to 4 cameras. The functionality is 
limited but works just fine for many small systems. 

 

Basic 

The commercial entry level is intended to be used by smaller companies, small 
shops, and home users. There is no support for external I/O, although I/O that 
comes with cameras and video encoders are available in Ethiris. 

 

Extended 

This level is suitable for medium-sized companies and shops. At this level, PTZ 
support is available. Integration via OPC comes at this level and also support for 
external I/O (not just I/O via cameras). 

 

Advanced 

This license level is suitable for larger companies and larger shops. In Advanced 
you get integrated support for Windows authentication and audit trail in Ethiris. 
You also get support for multiple storage devices, which mean you can store 
recorded video in several locations from one Ethiris Server. 

 

Premium 

This level is suitable for large and advanced installations. The possibility for 
expansion is almost without limit. At the Premium level, ActiveX and OPC Server 
are included in the license fee, providing a lot of integration possibilities. 

 

Note that Ethiris Client always is at the Premium level, only Ethiris Server exists 
in different license levels. 

These tables describe the different license levels: 
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Ethiris Server 
License level Free Basic Extended Advanced Premium 
Number of cameras

1
 4 1-20 1-40 1-64 1-250 

Max storage capacity Unlimited Unlimited Unlimited Unlimited Unlimited 

Max storage time 1 day Unlimited Unlimited Unlimited Unlimited 

Number of concur. clients conn. to server (the 
sum of clients, ActX, Ethiris Mobile & WQ)

1
 

2 3 5 20 Unlimited 

Requires Internet connection Yes No No No No 

Support for megapixel cameras      

Schedules      

Recording on event      

Continous recording      

Motion detection      

Centralized administration      

Browsing for cameras on the network      

Script engine      

Data logging      

PTZ      

Camera groups      

Connect I/O devices via plug-in 
(1 device / camera license) 

     

Connect Ethiris Mobile – Light mode      

Connect Ethiris Mobile – Full mode -     

E-mail/SMS -     

OPC-client - -    

Signing of exported jpg images - -    

Multiple streams from cameras
2
 - -    

Door controllers (1 door / camera license) - -    

Audio out to cameras / audio devices - -    

Audio devices  (1 device / camera license) - -    

Number of I/O signals via external  
OPC-server 

- - 32 128 Unlimited 

Number of preset positions/camera - - Unlimited Unlimited Unlimited 

Number of guarded tours/camera - - Unlimited Unlimited Unlimited 

TCP/http listeners - - Unlimited Unlimited Unlimited 

Connect Ethiris Server OPC-server - - Option Option  

Connect ActiveX client - - Option Option  

Connect WideQuick EthirisView - - - Option  

Multiple storage devices - - -   

Authorization - - -   

Possibility of pre authorization - - -   

Ethiris native users and user groups - - -   

Audit trail - - -   

Remote control of Ethiris Client via script - - -   

Dewarping of 360-cameras in Admin/Client - - -   

Support for UPS - - -   

Hardware acceleration - - -   

Support for GigE cameras - - - -  

Floating camera licenses - - - -  

Encryption of video and data storage - - - -  

Support for cluster and redundancy - - - -  

Support for database connections - - - -  

Support for alarm central functions - - - -  

                                                      
1
 The current hardware of the server/network may limit the actual number of cameras/clients that can be 

connected. It is up to the integrator to ascertain that the offered hardware can handle the proposed plant. 
2
 Maximum total number of video streams is 2 x the number of available camera licenses. 
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SIA-server - - - - Option 

 
 
 
Ethiris Client3 
Connected server’s license level Free Basic - Premium 
Number of servers a client can connect to 1 Unlimited 

Number of camera views/client view
4
 64 64 

Number of sections Unlimited Unlimited 

Support for megapixel cameras   
Hotspot   
Automatic camera switching   
Support for maps and pictures in camera 
views 

  

Export of recorded video   
Motion search in recorded video   
Digital zooming   
Remote control of client from external 
system via COM 

  

Client view activation via I/O   
PTZ   
Support for joystick   
Event triggered playback of sound files   
Authorization

5
   

Audit trail
5
   

Support for multiple monitors   
Interaction objects in camera views   
No license required   
Wide screen support (flexible client views)   
Event list   
Alarm list   
Pre authorization

5
   

Instant replay
5
   

Dewarping of 360-cameras
5
 -  

Connect to cluster -  
Hardware acceleration

5
 -  

 

 

 

 

 

                                                      
3 Ethiris Client is free of charge and exists only in one version. Availability of functions can depend on license level 
of Ethiris Server. 
 
4
 The current hardware of the computer/network may limit the actual number of cameras that can be displayed. It 

is up to the integrator to ascertain that the offered hardware can handle the intended function. 
 
5
 Availability of function depends on current license level of Ethiris Server. 
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Task 1, a Very Simple System 

This first task involves getting a system going that consists of one computer, 
which is to run both the server and client. The system consists of only one 
camera, an Axis M1054. The goal is to get live video from this camera and view 
it in Ethiris Client. 

The client part will consist of a section with one client view.  It could not be 
simpler than this. 

We assume that the necessary cameras have been installed in the network. This 
also involves the allocation of IP addresses to the cameras. See the 
documentation for the camera in question for further information. 

We also assume that Ethiris has been installed with both the client and the 
server on the same computer. See the Installation manual for more information 
on installing Ethiris. 

Below is a list of the names that will be used for the various objects in the 
system. 

Server part 

Ethiris server: Obelix 

Ethiris server IP address: 192.168.31.1  
(the IP address for the computer you use is probably different. Contact your 
network administrator if you are uncertain about this). 
By default, 127.0.0.1 is suggested as the IP address when a new Ethiris server is 
to be registered in the configuration tool or the client. This corresponds to the 
local computer and works just as well as the actual IP address. Please note that 
this only works for the local computer and not if you want to connect to 
another computer in the network. 

Camera: Door 

Camera IP address: 192.168.31.153 

 

Client part 

Section: Section One 

Client view name: View One 
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Instructions 

Ethiris configuration wizard  

From version 5.10 of Ethiris, there is a configuration wizard that starts 
automatically the first time you start Ethiris Admin. The condition for the wizard 
to start is that your Ethiris Admin project is empty, which is the case when you 
start Ethiris Admin directly after a new installation of Ethiris. 

The configuration wizard helps the user get started with Ethiris, and the first 
three tasks in this Getting started manual can be done automatically by the 
configuration wizard. 

When you start, the following dialog is displayed. 

 
Figure 2.12 The welcome dialog in the configuration wizard. 

If you are content with the default settings for all the steps, you can click Finish 
immediately. Then the wizard will connect to the local Ethiris Server (the one 
running on the local computer), search for available cameras on the network, 
and configure the cameras for automatic recording on motion and schedule. 
Furthermore, the wizard will create a client configuration based on the found 
cameras, and finally, the Ethiris Client will automatically be started with the 
newly created configuration. 

So, if you want, you can run the configuration wizard and therefore skip the first 
three tasks in this manual and go directly to 



Getting Started Getting started with Ethiris  

Task 1, a Very Simple System   
 

2:14 

Task 4, Deleting Video on page 2:60. 

If you don’t want to run the wizard, you simply click the Cancel button. 

A thorough description of the configuration wizard can be found in the Ethiris 
Admin manual. 

The remaining sections for this task are based on a manual configuration, 
without the configuration wizard. 

Without the configuration wizard 

When Ethiris is newly installed, the system is empty since no cameras are 
connected to the system. The first thing we have to do is to tell Ethiris Server 
that there is an Axis M1054 camera in the network that we want to use. 

Although Ethiris consists of several program parts, not all of them are in the 
start menu. The server part is implemented as a service. A service can simply be 
configured from the services program in the Control Panel in respect of whether 
it is to start automatically when the computer is started. When Ethiris is 
installed, the server part is configured to start automatically when the 
computer is started. This means that the Ethiris server is always running. 

The installation program adds a shortcut to the client part, Ethiris Client, and 
the configuration program, Ethiris Admin, to the start menu. Furthermore, a 
shortcut to Kentima License Handler is added to the start menu.  

Please note that, in some installation types, the camera simulator Ethiris 
Camera Simulator is also installed. If this part were not deselected during 
installation, it would be a 4

th
 option in the start menu. There may also be 

shortcuts to the OPC Server configuration tools. 

OK. Let’s get going with the guided tour. 

1. Click the Start menu and select Programs. 

2. Select the program group Kentima Ethiris. 

Start Ethiris Admin 

3. Click the program icon Ethiris Admin. 
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Figure 2.13 System configuration for an empty system. 
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Language 

Ethiris Admin and Ethiris Client use the currently selected language in the 
Control Panel, if possible. Beginning with version 5.14 there are 8 different 
languages to choose from for Ethiris Admin and an additional 12 (for a total of 
20) for Ethiris Client; English, Swedish, French, German, Russian, Norwegian, 
Dutch and Spanish are available for both Admin and Client. For Ethiris Client are 
also Croatian, Danish, Finnish, Italian, Polish, Portuguese, Serbian, Slovenian, 
Arab, traditional and simplified Chinese and Turkish available. 

To select another language, select the menu Tools->Select Language. 

Firewall 

If a firewall is activated on the computer where Ethiris Server runs, certain ports 
have to be opened to make Ethiris function properly. 

Connecting to an Ethiris Server 

To the left of the window is a treeview, called Ethiris Explorer, which, at this 
stage, is empty apart from the root element, Ethiris Components. You can 
administer several different Ethiris servers from the same Ethiris Admin 
program. Before you can start to work with a system, you have to connect to 
the Ethiris server(s) you want. 

1. Select the File->Connect Ethiris Component->Ethiris Server… 
menu. 

A connect dialog is displayed with information on the local computer 
already entered.  

2. Click on the button Manual connect to enter an IP address 
manually to connect to. 

 

 
Figure 2.14 Connect Ethiris server dialog. 

3. Click Connect. 

When a new Ethiris Server is connected to Ethiris Admin, the relevant 
configuration is read from the server. The relevant information is entered in the 
treeview. 
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Figure 2.15 Ethiris Admin with one server connected. 

Add a camera 

The next step is to add a camera that represents the Axis M1054 available on 
the network. 

1. Double-click the Cameras node in the treeview to open the 
Cameras panel. 

 
Figure 2.16 Ethiris Admin with Cameras panel opened. 

There are two ways to add cameras to the server configuration; manually or by 
browsing for available cameras on the network. 

The browsing function utilizes ONVIF and UPnP (Plug-And-Play), i.e., only 
cameras with support for ONVIF or UPnP will be found. 
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To enable UPnP on the computer running Ethiris Admin, open Windows firewall 
settings from the Control Panel and select Allowed programs. 

 
Figure 2.17 Allowed programs list in Windows 7. 

Make sure Network Discovery is enabled. 

Browse for camera(s) 
button. 

2. Click the Browse for camera(s) button. 
 

 
Figure 2.18 Dialog for browsing cameras on the network. 

3. Select the desired camera(s). In this case, the Axis M1054 and click 
the Add button. 

The Axis M1054 camera is immediately added to the list of cameras in Ethiris 
Admin. The default name is Camera 1, which we will soon change to Door. 
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Figure 2.19 The Axis M1054 camera is added to the network cameras list in Ethiris 
Admin. 

4. Now, click in the field Name and enter Door instead of Camera. 
The name is instantly updated in the treeview as well. 

 
Figure 2.20 Door is entered as the new name of the camera. 

5. If the login and password should be something else than the 
default root and pass, you may change those corresponding fields 
as well. 
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Figure 2.21 You may have to change the login and password. 

Save button. 6. Click the Save button in the main toolbar for saving the new 
configuration to Ethiris Server. 
 

When the configuration is saved, Ethiris Server is updated with the new 
information and starts to retrieve video from the camera. Before saving, Ethiris 
Server knows nothing about the camera and consequently will not start 
retrieving video until the configuration is saved. 

Notice that the camera icon is gray before the configuration has been saved. 
This indicates that no video is retrieved from the camera. The reasons can be 
many. In this case, it’s because the camera has not yet been saved to the 
server’s configuration. 

To manually add a camera to the server configuration, simply right click the 
Cameras node in the treeview and select New-> Camera in the popup menu or 

click the New Camera button  in the Cameras panel’s toolbar. Each time this 
is done, a new row is created in the cameras list. 

The default Manufacturer, Generic, and Model, Generic, are pre-selected. 
Simply select appropriate values in the drop-down lists for each camera. 

When manually adding cameras to the configuration, you also have to enter the 
IP address manually. 

There is a warning (the red dot with an exclamation mark) when one or several 
values are not OK for a camera. In the example below, the IP-address is missing. 

Use the warning icon 
to get more information 

Hold the mouse pointer over the warning icon  to get information about 
what is wrong. 
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Figure 2.22 New cameras added. 

If you don’t want all cameras, simply select undesired cameras in the list by 

clicking on the left-most column and then click the Delete camera  tool 
button. 

It’s perfectly alright to select multiple cameras simultaneously by clicking one 
row, holding the mouse button down, and then moving the mouse pointer to 
other rows. Alternatively, you can use the Ctrl-key or the Shift-key to select 
multiple rows. 

More camera properties 

As new cameras are added to the server configuration, they appear in the 
treeview as well. Click on the “+” at the camera Door to expand the tree and 
view other categories of camera properties. 

 
Figure 2.23 Camera node expanded in the treeview. 
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You can open a specific property panel for each of the nodes in the treeview by 
double-clicking the treeview node, even the node representing the camera 
Door itself.  

 
Figure 2.24 Camera properties panel opened. 

Note that panels that were already opened are still open. Each panel has a tab.  
A panel can be moved and docked in a lot of different ways. Please see the 
Admin Configuration manual for information about how to work with panels. 

After a while, there may be quite a few panels opened. Feel free to close them 
by clicking the close button in the upper right corner of the panel or right-
clicking any of the open panels’ tabs and select any of the menu items for 
closure. The information entered on the panel is still there even after the panel 
is closed. 

To make the server use the new configuration, we must save it to the server. 

Click on the Save the selected component  to save the configuration. 

Alright, this completes the server configuration for now. 

Creating a client configuration 

We also have to configure the Ethiris Client before we can view live video. Now, 
this is done from Ethiris Admin as well. 

Again, you can create a new client configuration using the configuration wizard. 
Select File->New Ethiris Component->Ethiris Client using wizard… to try this out. 
Read more about the configuration wizard in the Admin configuration manual. 

In this manual, we do it the hard way. 

For the time being, Ethiris Clients cannot be configured online, but rather 
offline. This means that if no client configuration exists, you have to create a 
new client configuration. Since client configurations are stored on Ethiris Server 
you must first select the Ethiris Server that should handle the new configuration 
in the treeview. 

1. In Ethiris Admin, Select the  
File->New Ethiris Component->Ethiris Client… menu. 

This will create a new client configuration on the selected server. This new 
configuration gets a default name like Client Configuration or similar and is 
shown in the treeview under the node Client configurations for the selected 
server. 
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2. Now double click on the new configuration node, and Admin 
will open the configuration under the Ethiris Clients node in 
the treeview. 

 
Figure 2.25 New Ethiris Client configuration in the treeview. 

3. Double click on the newly opened configuration under the 
Ethiris Clients node to open the client configuration panel. 

 

 
Figure 2.26 Ethiris Client configuration panel. 



Getting Started Getting started with Ethiris  

Task 1, a Very Simple System   
 

2:24 

4. Enter the preferred presentation name for the client 
configuration in the field Display name. This is the name that 
will be displayed in the treeview in Ethiris Admin and in some 
contexts in the client program. 

5. Click Save on the toolbar to save the configuration to the 
server. 

The next step is to define which Ethiris Servers this particular Ethiris Client 
configuration will use. 

1. Double-click the Used Servers node in the treeview to open the 
Used servers panel. 

 
Figure 2.27 Ethiris Admin with Used servers panel opened. 

2. Click the Add server button  in the Used severs panel’s toolbar to 
open the Add Server to Client Configuration dialog. 

 
Figure 2.28 Dialog for connecting an Ethiris Server to a client configuration. 

3. Leave Obelix selected in the list of already loaded server 
configurations and then click the Select button. 

Now, the treeview is updated with information about which Ethiris servers are 
connected to the client configuration. 



Getting started with Ethiris Getting Started 

 Task 1, a Very Simple System  

 2:25  

All cameras that are part of the server configuration are now available in the 
client configuration. Various client views can be defined in the client 
configuration, and all cameras available to the client configuration can be used. 

Click the +-sign in the treeview to the left of Obelix to view the available 
cameras. 

 
Figure 2.29 Ethiris Admin treeview is updated with the connected server. 

Creating a section and a view 

Next to the bottom of the client treeview, there is a node called Views. This is 
where you create sections and client views that shall be part of the client 
configuration and available for the operator running Ethiris Client. 

1. Right-click the Views node in the treeview and select  
New->Section in the popup menu. 
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Figure 2.30 Create a new section in the client configuration. 

2. A Section node is created in the treeview. Enter a name for the 
section, e.g., Section One. 

3. Right-click the new section node and select New->View in the 
popup menu. 

4. A View node is created in the treeview. Enter a name for the view, 
e.g., ViewOne. 

5. Under the new View node in the treeview, a Layout node is 
automatically created. Double-click the Layout node. Ethiris 
Admin shall now look something like Figure 2.31. 
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Figure 2.31 View layout in Ethiris Admin. 

In the View One – Layout panel, you can choose among several pre-defined 
layouts. See Figure 2.32. 

 
Figure 2.32 Pre-defined layouts. 

You can also choose the number of columns and rows directly for the client's 
view. See Figure 2.33  
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Figure 2.33 Select the desired number of columns and rows for the client view. 

 

6. For now, keep the layout with one column and one row. Click in 
the black area to display all available cameras to the right in the 
layout panel. Check the Use checkbox for camera Door to select 
this camera in the client view. This means that when the operator 
selects the View One view in Ethiris Client, live video will be 
displayed from the camera Door. 

 
Figure 2.34 Select which camera to display in the client view. 
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Save the project 

In Ethiris Admin, there is a project concept keeping track of all Ethiris 
components that are part of the project. There is a hidden default project that 
“remembers” which Ethiris components were loaded into Ethiris Admin last 
time Ethiris Admin was used. This means that you don’t have to explicitly use 
projects if you don’t need to handle several different projects on the same 
computer. 

1. Click the Save All button in the Ethiris Admin toolbar to save the 
current project and all components in the project since we have 
already specified what server should handle it and the name of 
the client configuration we don’t have to do that now. 

Starting Ethiris Client 

Now it is time to switch to the client program. The task involves being able to 
watch live video from the Axis M1054 camera added to the configuration. 

There are two alternatives for starting the Ethiris Client program. Either you 
start the client from the start menu, or you right-click the client in the treeview 
in Ethiris Admin. 

1. Click the Start menu and select Programs. 

2. Select the program group Kentima Ethiris. 

 

Starting Ethiris Client. 

3. Click the program icon Ethiris Client. 

The first time the Ethiris Client is run, a Connect dialog is displayed to allow the 
selection of a configuration file from an Ethiris Server. Select a server where 
you which to fetch the client configuration from the list. You can also click on 
Manual connect to enter the server IP-address manually. 

 
Figure 2.35 The Connect dialog to fetch a client configuration. 

Just click the Connect button to proceed. 

Once you have selected an Ethiris Server, you will be presented with a list of 
client configurations stored on that server. 

 



Getting Started Getting started with Ethiris  

Task 1, a Very Simple System   
 

2:30 

 
Figure 2.36 The dialog for selection of client configuration. 

Open a configuration 

Open Ethiris Client 
configuration button 

The above dialogs can also be reached from the Open configuration button in 
the Ethiris Client toolbar. 

Select the configuration we just created in Ethiris Admin and click the Open 
button. The configuration will immediately be loaded in Ethiris Client, and the 
first view in the first section is automatically selected. If everything works as 
expected, the live video should now be displayed from the Axis M1054 camera. 

 
Figure 2.37 Live video in Ethiris Client. 

To the left, in the Sections Explorer tool window, are buttons for selecting the 
section. As we have only defined one section, Section One, there is just one 
button.  

To the right, in the Views Explorer tool window, are the view buttons that are 
defined for the relevant section. Here too, there is just one button as we have 
only defined one view button for this section. The first view button in a section 
that displays any form of client view is selected automatically when the section 
is selected. 
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At the bottom of the window is the Cameras tool window, which contains all 
available cameras. Hold the mouse pointer over the panel name for popping up 
the panel. 

 
Figure 2.38 The Cameras tool window in Ethiris Client. 

From the Cameras tool window, you can select one or several desired cameras 
and display them in the Default Live panel, a new live window or load them in 
the Player. More about this later on. 

What have you learned? 

Task 1 is now complete. So, what have you learned? You have learned how to 
configure a simple Ethiris system with one camera. You have learned how to 
connect to an Ethiris server in Ethiris Client and how to create a section with a 
camera and a view button. The principle for creating configurations for Ethiris 
Server and Ethiris Client is the same regardless of the number of cameras. 

In the next task, we will learn to record video from our camera, both manually 
and in connection with motion in the video. 
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Task 2, Recording Video 

This task will teach us how to record video, both manually and automatically, 
via motion detection in the video. 

There are two main types of recording in Ethiris, Event-controlled recording and 
Continuous recording. 

The only difference between these types is that event-controlled recording has 
a predetermined time (pre/post-event time) that is recorded in connection with 
an event. You define both the time for recording before the event and the time 
for recording after the event. Recording takes place for as long as the event is 
active and subsequently for the time defined for recording after the event. If, 
for example, you use motion detection as the condition for event-controlled 
recording by a specific camera and you have selected 60 seconds before, and 30 
seconds after, the recording will start 60 seconds before the motion was 
detected, will continue for as long as the motion is detected and, when the 
motion is no longer detected, will continue for a further 30 seconds. 

Continuous recording continues for as long as the recording condition is active. 

An event in Ethiris may be many different things and also a combination of 
several different events (input signals). 

Examples of events are a motion detector detecting motion, a schedule being 
active, or digital input is set. In Ethiris, all types of events are represented by an 
input signal that can have the value 1 or 0 (true/false). F ex a schedule is at 
every moment either active or inactive, 1 or 0. a motions detection detects 
either motion or no motion, 1 or 0. 

Each camera that is defined in the Ethiris server configuration generates a 
number of signals that can be used to configure functionality in Ethiris. We will 
talk about this later in the manual. For now, we will say only that, for each 
camera, two output signals are generated, among other things. They are 
RecordEvent (Event-controlled recording) and RecordContinuous (Continuous 
recording). These output signals can be used as variables in scripts to define 
conditions for when the respective output signals are to be enabled.  

Use the panel 

Recording  to configure 
recording  

From version 5.6 of Ethiris, there is a new panel in the server part of Ethiris 
Admin, which essentially facilitates recording configuration. The panel, which is 
called Recording, may be used for configuring both event-controlled recording 
and continuous recording. As a recording condition, you can use both 
schedules and/or motion detectors. If you need more advanced conditions for 
recording, you can still use a script. The whole idea behind this new panel is 
that in most cases, you should not have to use a script for recording 
configuration. 

Instructions, Manual Recording 

The manual recording button is a special case in Ethiris. It enables event-
controlled recording for the camera that is currently active in Ethiris client. The 
duration of the event is 0, i.e., recording takes place only for the time that has 
been defined before the event and the time defined for recording after the 
event, the sum of pre/post-event time. 
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The manual recording button circumvents any conditions that have been 
defined in the panel Recording or for the output signal RecordEvent, i.e., 
regardless of whether the condition defined for RecordEvent for the relevant 
camera is met or not, clicking the manual recording button will generate a 
recording. 

If Ethiris client has not yet been started, start it now. 

In Ethiris Client, the manual recording button is located in the toolbar in the 
upper left corner. 

 
Figure 2.39 The manual recording button in Ethiris Client. 

Testing manual recording 

1. When a certain camera view is selected in Ethiris Client, this is 
indicated by a green frame. Since there is only one camera view in 
the current client view, it is automatically selected. Later on, when 
we have several camera views, you can select a camera view by 
clicking on it. 
 

 
Figure 2.40 A selected camera view in Ethiris Client has a green frame surrounding it. 
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 Recording button 2. Click the recording button in the toolbar to start recording video. 
To make it all a little more interesting, try to capture some activity 
in the video, i.e., record when something is happening in front of 
the camera. 

 

Viewing recorded video 

Recorded video is presented in the Player panel in Ethiris Client. However, every 
event-controlled recording is also represented by a row in the Events list in the 
Events panel. 

 
Figure 2.41 The Event list in Ethiris Client displays all event-controlled recordings. 

There are also other kinds of events in the event list. More about this later on. 

1. Bring up the Events list by clicking the Events panel. 

2. Double-click the Camera Record Event item on the list. 

This immediately brings up the Player panel, the relevant camera is selected 
into the Player, and the corresponding time is automatically selected. 



Getting Started Getting started with Ethiris  

Task 2, Recording Video   
 

2:36 

 
Figure 2.42 The Player in Ethiris Client is used for playback of recorded video. 

The timespan in the Player is 30 minutes as default. This time is also indicated 
by the timestamps in the left (start time) respectively, the right (stop time) end 
of the timelines. In the example above, the start time of the timelines is at 
09:53:40, while the stop time is at 10:23:40 for a total of 30 minutes. When you 
scroll (move the time span), you move the 30-minute “window”, in effect 
updating the timestamps indicating the start time and stop time for the 
timelines. You can move the time span in two ways; Click the “arrow buttons” 

at the left  , respectively right  edge or drag the dark grey time band 
between the buttons to left/right with the mouse. 

You can change the time span in several ways. To the left, in the maneuver 
panel, there is a time span selection list. 

 
Figure 2.43 Select an appropriate time span in the time span selection list. 

Select one of the time spans in the list. Another way is to click on the Expand 

Time span button  to double the current time span or the Shrink Time span 

button  to half the current time span. 

Yet another way is to zoom in the timelines by drawing a rectangle. Left-click 
the mouse, drag the mouse pointer to select an area of interest, and finally 
release the mouse button to make the selection. 

 
Figure 2.44 Zoom in interesting sequences in the timelines. 
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A Time ruler is determining at what time to display the recorded video. 

 
Figure 2.45 The Time ruler determines what time is to be displayed in the recorded video. 

You can move the ruler back and forth to do a rapid search through the 
recorded video. The frame(s) corresponding to the current timestamp is 
displayed in the camera view(s) above the timelines. 

As you probably have noticed by now, recorded video is indicated in the 
timelines with either red or blue color. Red color is used for event recorded 
video while blue color is used for continuously recorded video. When the ruler 
points to a recording (red or blue color), the corresponding video frame is 
displayed in the camera view(s) above. 

Click the Play button  to start playback of the video. 

You can jump between recordings by clicking the Step backward to previous 

video segment button  or the Step to next video segment button . Feel free 
to try these buttons out. 

You can alter the playback speed by moving the slider handle, see Figure 2.46. 

 
Figure 2.46 Move the slider handle to change the playback speed. 

The speed can be set between 1/128 and 128x the normal playback speed. 

Alright, let´s go back to our manual recording… 

A manual recording of video is processed by the system as if it were a standard 
event recording. The only difference is that the event is enabled manually by 
clicking the recording button instead of automatically, which is the case with an 
event recording via, for example, motion detection in the video. 

When you double-click the corresponding event in the Events list, the Time ruler 
is set to the exact event time. In practice, this means in the middle of the red 
segment since, as default, there are 10 seconds of pre-alarm recording and 10 
seconds of post-alarm recording. Go to the beginning of the recording by 

clicking the Step backward to previous video segment button . 

You may have wondered why there were 20 seconds of recorded video. 

In the next section, we will look at how to set the frame rate and the time 
before and after the event for an event recording. 

Recording settings 

The recording settings for each camera are entered in the server configuration 
in Ethiris Admin. We will now increase the time for event recording and also 
increase the frame rate to 25 frames per second. 

The recording time for an event is divided into two parts, the time for recording 
before the event and the time for recording after the event. 
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The default setting specifies 10 seconds before an event and 10 seconds after it. 
We will change this to 20 seconds before and 15 seconds after the event. 

The frame rate is set as the number of frames per second. 

1. In Ethiris Admin. 

2. In the treeview to the left in the server configuration, expand the 
tree right down to the node Recording, i.e., click the + sign to the 
left of each line in the treeview where this is necessary to open 
the following branches in the tree: Ethiris Components\Ethiris 
Servers\Obelix\Camera\Recording. 

The treeview should now look roughly as in Figure 2.47 on page 2:37. 

 
Figure 2.47 Treeview expanded to the node Recording. 

3. Double-click the Recording node in the treeview to open the 
Recording panel. Change the following parameters in the section 
Event Recording: 

4. Enter 25 for frame rate. Note that when selecting the cell in the 
table, the appearance changes, and you can change the value via a 
so-called spin box. You can also use the mouse wheel to 
increase/decrease the value or simply enter a value via the 
keyboard. 

5. Enter 20 for the time before. 

6. Enter 15 for the time after. 

7. Leave the other settings as they are. 
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Figure 2.48 Settings for video storage for the camera Door. 

To send the changes to the server, click the save icon in the Ethiris Admin 
toolbar.  

Try the new settings by manually starting a new recording. For information on 
how to do this, see Testing manual recording on page 2:33. 

Search for events (Filter) 

By default, the event list displays all events that have occurred in the last hour. 
Sometimes you want to see more events, or perhaps you want to see fewer 
events. 

To filter precisely the events, you are interested in. You use the Select time 

button  in the Events panel in Ethiris client. 

We will now filter events so that only events that occurred between 2012-02-14 
at 14:00:00 and 2012-02-14 at 15:00:00 are displayed. 

The date and time below probably do not match your events, so feel free to 
change the date and time to something more suitable.  

1. Select the Events panel in Ethiris Client. 

2. Click the Select time button. The filter dialog is displayed. 

3. Click the down arrow in the selection list for Oldest Date/Time. 
Select 2012-02-14 in the calendar. Uncheck Oldest available if 
necessary. 

4. Click the figure indicating the hour. Scroll up or down with the 
arrow keys or enter 14. 

5. Press the right arrow key to select the minute value. Set 00 with 
arrow up/down or enter the value. 

6. Ensure that the second value is on 00. 

7. In the Newest Date/Time box, unselect the Newest available 
checkbox and then set 2012-02-14 15:00:00. 

8. The dialog should look roughly as in Figure 2.49. Click OK when you 
are happy with your filter settings. 
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Figure 2.49 Example of filter for event list. 

The event list is updated immediately to display the events that match the filter 
set. 

In the next exercise, we will learn how to record video continuously instead of 
recording on a specific event. 
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Instructions, Continuous Recording 

We will now set the camera Door so that it continuously records video with a 
frame rate of 2 frames per second. In this mode, we will record continuously 
from when we save the new configuration. Otherwise, it is usual to link the 
recording to a schedule that defines the times of day at which recording is to 
take place. 

If Ethiris Admin has not yet been started, start it now. 

Starting continuous recording 

1. Open the panel Recording. For information on how to do this, see 
Recording settings on page 2:36. Change the following parameters 
in section Continuous Recording: 

2. Set the Frame Rate to 5 frames per second (fps). 

3. Select schedule Always. 

4. Leave the rest of the parameters as they are. 

 
Figure 2.50 Settings for continuous storage from the camera Door. 

To send the changes to the server, click the save icon in the Ethiris Admin 
toolbar. 

Automatic deletion of continuously recorded video 

Continuous recording requires a great deal of hard disk space. If we use VGA-
sized frames (640*480 pixels) with medium level compression, we can reckon 
with an average frame size of 25-40 kB. In our example with two frames saved 
per second, we use, at a high estimate, 2 * 3 600 * 40 kB, which produces just 
over 280 MB per hour. This means about 6.5 GB per 24 hours, provided that we 
record round the clock. 

To avoid filling the hard disk up completely, we can set automatic deletion of 
old video. Another reason for automatic deletion may be that an authority 
permit or other regulation forbids the storage of video for longer than a specific 
time. 
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There is a global setting for cleaning up old video that applies for all cameras in 
a certain Ethiris Server. If you want you can override this setting for individual 
cameras. 

First, we will have a look at the global setting. 

1. Double-click the Storage node in the treeview.  

 
Figure 2.51 Global settings for automatic deletion of old video. 

The default setting in Ethiris is that video will be deleted after 30 days. Here you 
can change this to another time or simply turn the function off completely. 

If you want another setting for one or several cameras, you can override the 
global setting for desired cameras. To set automatic clean up for the camera 
Door to 1 hour, do the following: 

1. Go to the Camera Storage panel for the camera Door.  

2. Check the Override storage Clean Up setting checkbox. 

3. Set 0 Days, 1 Hour, and 0 Minutes. 

 
Figure 2.52 Settings for automatic deletion of recorded video. 

Ethiris checks every 30 seconds whether there is video that is too old on the 
hard drive. 



Getting started with Ethiris Getting Started 

 Task 2, Recording Video  

 2:43  

The above setting means that every 30 seconds, the program checks whether 
there is any saved video that is older than 1 hour. If any old video is found, it is 
deleted automatically. 

To send the changes to the server, click the save icon in the Ethiris Admin 
toolbar. 

 

Viewing continuously recorded video 

Ethiris Client is used for viewing the video recorded via continuous recording. If 
Ethiris Client has not yet been started, start it now. 

1. Select the Player panel. 

Continuously recorded video has no connection with an event. Therefore they 
cannot be accessed via the event list. Instead, you go directly to the Player. 

The first time you go to the Player since Ethiris Client was started, there are no 
cameras selected in the timelines. You can select cameras in several different 
ways. 

You can select one of the View buttons in the Views panel. All views defined for 
live viewing can also be used for playback of recorded video. 

You can also select desired cameras from the Cameras panel and load them 
into the Player. 

In this exercise, we choose the former alternative. 

2. Click the View One view button. 

 
Figure 2.53 Continuously recorded video in the Player. 

When you enter the Player for the first time, the time span in the timelines is 
set to 30 minutes and now is to the right in the timelines. This means that the 
latest half-hour is displayed in the timelines. 

For information about how to manage the Player, please refer to Viewing 
recorded video on page 2:34. 
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Instructions, Recording in the Event of Alarms 

Now we will add motion detection for the camera Door and link it to the start of 
recording of video from the same camera. 

If Ethiris Admin has not yet been started, start it now. 

Defining motion detection 

1. In the treeview, double-click the Recording node. 

2. In the Motion Detector column for the camera Door, select the 
<New Standard Motion Detector>. 

 

 
Figure 2.54 A new standard motion detector is selected. 

This action automatically creates a new motion detector for the camera Door. 
The detector detects motion in the whole image, and if you want to mask parts 
of the image, you can go directly to the motion detector panel by clicking the 

new icon to the right of the Motion Detector column. 

Mask parts of the 
frame by checking the Exclude 
area from motion detection 
checkbox. 

In a new motion detector, motion is detected in the entire image. The area 
monitored can be limited by painting over irrelevant parts of the image. This is 
done by checking the Exclude area from motion detection box and selecting the 
appropriate pen size. Paint over by holding down the left mouse button and 
dragging the mouse over the camera frame. Erase by holding down the right 
mouse button. Use the Clear mask or Fill mask button to remove all masking or 
mask over the entire frame. In the example below, the top left part is masked. 
This is displayed via squares with a size corresponding to the pen size selected, 
which has a grid pattern. 

The main idea is that only the Triggering Level and possibly a mask should have 
to be altered for a motion detector. 

There are some more settings hidden under Advanced Settings. Click the 
Advanced Settings button to display these. 

You can always reset the settings to one of the three pre-defined settings; 
Insensitive, Standard, or Sensitive by clicking the corresponding button. 
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Figure 2.55 Click Advanced Settings for displaying the advanced settings options. 

Experiment with the parameters Sensitivity, Resolution, Frame rate, and 
Triggering level. Ensure that something is moving in the video. This makes it 
easier to set the motion detection. 

Motion is indicated with green, yellow or red pixels in the frame. The motion of 
individual pixels is displayed in green. Groups of pixels with motion are 
displayed with yellow or red pixels. Yellow indicates that the total motion in the 
frame is under the selected trigger level. When the trigger level is exceeded, the 
motion is displayed with red pixels. When it is red, motion detection should 
generate an alarm. 

We will give a brief account of the various parameters here. A more detailed 
description is available in the Admin Configuration manual. 

Exclude area from motion detection allows you to paint over parts of the frame 
that do not need to be monitored for motion. Unmonitored parts of the frame 
are still recorded in the event of an alarm. They are just not monitored for 
motion. Check this box if you want to exclude parts of the frame from motion 
detection. 

Pen Size indicates the current width of the pen when masking the frame for 
motion detection. 

Clear mask removes the entire mask. The whole frame will then be monitored. 

Fill mask places a mask over the entire frame. In this situation, no part of the 
frame will be monitored. But the function is useful if only a small part of the 
frame is to be monitored. 

Noise reduction specifies how to apply noise reduction filtering in an attempt to 
eliminate pixels that detect motion although no neighbor pixel does so. The 
default value will remove small and medium-size noise. This setting can be 
useful for cameras that work in low light conditions. 
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Background filtering is used to compare motion against a more static 
background instead of just the previous frame. This means that real motion 
becomes more distinct, and there is a certain reduction in noise. 

Number of frames specifies how many frames are to be used for mean 
calculation of the background. This may be 2-10 frames. 

Filter time is specified in seconds and defines the time during which the 
background frame is to be calculated. In the example below, 5 frames are used 
during a filter time of 10 seconds. This means that the background frame is 
calculated as a mean of 5 frames backward in time, which are sampled at 
intervals of 2 seconds. 

Sensitivity specifies the extent of change in color required for it to be 
interpreted as motion. A higher value results in higher sensitivity. A value of 60 
is the default and should work in most circumstances. 

Resolution specifies how fine motion is to be detected. 10 is the highest value. 
With this value, every pixel is checked in the area monitored in the frame. A 
higher resolution puts a greater load on the server. On many occasions, a lower 
resolution is adequate. However, when setting motion detection, it is useful to 
have a higher resolution to make it easier to see pixels with motion. When you 
are happy with the other settings, you can lower the resolution to reduce the 
load on the server. The default value is 8, but a value of 6 or 7 probably will 
work just as fine. 

Frame rate specifies how often motion is to be checked. The higher the frame 
rate, the higher the accuracy, but also the higher the load on the server 
performing the comparison. It is worth considering that the lower the frame 
rate, the greater the differences between frames if something is moving in the 
frame, for example, a person passing by the camera. However, the time should 
not be so long that the person can pass by between two comparisons. The 
default value is 2 frames per second. This is a value that should work in most 
circumstances. Again, this has nothing to do with the frame rate of recorded 
video. This setting only affects how often motion detection shall be performed. 
Settings for recording are done in the Storage panel for the camera. 

Measure only key-frames is used for decreasing the load on the server 
computer if the camera streams video in the format MPEG-4 or H.264. A MPEG-
4/H.264 video stream consists of key-frames (I-frames) and P/B-frames where 
key-frames are whole images, and P-frames/B-frames are parts of images 
describing only the changes since the last image was sent. If Measure only key-
frames is not checked, Ethiris Server has to decode all images in the video 
stream, both key-frames and P/B-frames. Usually, key-frames are sent once or 
twice every second and thus completely sufficient for motion detection. 

Actual frame rate displays the actual frame rate and is especially useful for 
determining how often key-frames appear if you have chosen the setting 
above.  

Trigger level specifies in % how much of the area monitored must contain 
motion for it to be interpreted as motion detection overall. Perhaps small 
animals can pass by while people should be detected. This calculation does not 
include green pixels, i.e., individual pixels with motion. It must be groups of 
coherent pixels with motion. 

Number of frames with motion for triggering specifies how many motion 
detections in succession are required to produce an alarm. The aim of this is to 
avoid alarms if the camera frame suddenly changes brightness, for example, 
because the camera is adjusting its aperture or someone has switched on a 
light. 
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When an alarm would have been produced, a symbol is displayed to the right of 
the Advanced Settings button. 

See Figure 2.56 for an example of settings. 

When you are satisfied with the settings, you may close the Motion Detector 
panel. Closing the panel relieves the computer from the work of painting live 
video. All the settings are internally stored in Ethiris Admin (in the treeview) 
and remains until you save the configuration.  

 
Figure 2.56 Example of settings for a motion detector. 

What have you learned? 

Task 2 is now complete. In this task, you have learned various ways of recording 
video with Ethiris. This can take place continuously or in connection with an 
event. An event may, for example, be generated via motion or manually by 
clicking a recording button. 

In the next task, we will look at the options for limiting recording and live video 
viewing via a schedule. 
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Task 3, Using Schedules 

This task will teach us how to limit recording via events and live video viewing 
by using schedules. 

There are places where it is not permitted to film during certain times of the 
day. In such cases, you can use schedules to specify precisely the times at which 
the cameras are to be active. 

Several different week-based and/or day-based schedule templates can be 
created separately with different active times. From the schedule templates, 
you then create the schedules. Each schedule can have its own unique 
deviations. Normally the schedule moves along according to the schedule 
template. However, in the event of any deviations, the deviating template 
applies instead. Deviations can be defined for a particular week or a particular 
date. Several deviations can be defined for each schedule. Each schedule can 
then be used in the desired number of contexts, for example, to control when a 
camera is to display live video or when the camera is to record video. 

A schedule linked to a camera’s Enable output signal controls the times at 
which the camera is to send video, i.e., live video viewing. 

A schedule linked to a camera’s RecordEvent or RecordContinuous output signal 
controls the times at which the camera can record video. The schedule signal 
can be combined with other input signals such as motion detection. 

When it comes to controlling recording with a schedule, you should use the 
panel Recording to associate a schedule with event and/or continuous 
recording. 

Instructions 

If Ethiris Admin has not yet been started, start it now. 

Add a schedule via the Recording panel 

We will now create a schedule with the corresponding template via the 
Recording panel. The schedule and the template will get a default name and 
default times. These can be changed. As a default, the schedule is inactive 
workdays between 06:00 – 18:00 and Saturdays 09:00 – 15:00, i.e., it is active 
outside normal work hours.  

1. Double-click the node Recording in the treeview. 

2. In the section Event Recording and the column, Schedule pick 
<New Schedule>. See Figure 2.57. 
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Figure 2.57 Create a new schedule directly from the panel Recording. 

A new schedule with the corresponding template will immediately be created 
under the node Schedule definitions, see Figure 2.58. 

 
Figure 2.58 A new schedule with the corresponding template is immediately created 
under Schedule definitions. 

Double-click the New Template to see/change the scheduled times. 

 
Figure 2.59 The schedule template is predefined with certain times. 
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The new schedule is common for the whole Ethiris server, i.e., all cameras in 
the system may use the same schedule. 

If you want, you may also create templates and schedules directly under the 
node Schedule definitions. 

Add a schedule template 

We will now create a schedule template called NormalTemplate. It will have 
times that are inactive on working days between 07:00 and 18:00, i.e., it is 
active outside normal working hours.  

It might be a schedule template for monitoring an office, where filming should 
not take place during working hours when the staff usually is at work. 

1. In the Ethiris Server’s configuration treeview, open the Schedule 
definitions node. 

2. Double-click the Templates node in the treeview to open the 
Schedule Templates panel. 

 Add a new template 3. Click the Add a new template tool button in the Schedule 
Templates panel’s toolbar. A new item is created in the Schedule 
Templates list. 

4. In the list, enter NormalTemplate in the Name column. 

5. In the treeview, under the Templates node, a new item, 
NormalTemplate is created. Double-click this item to open the 
panel for this template. 

When you create a new schedule, there are already transitions defined. 

6. Adjust the transitions by dragging them with the mouse. The 
red to 07:00 and the green to 18:00. Start doing this for 
Monday. See Figure 2.60 on page 2:50. 

 
Figure 2.60 Adjust the time by dragging transitions. 

7. When you got Monday right, you can copy this day to Tuesday - 
Friday. Select Monday by clicking on the text Monday. Then click 
the Copy selected day button. See Figure 2.61 on page 2:51. 
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Figure 2.61 You can copy the settings for one day to other days. 

8. Now, select Tuesday and then click the Paste button. Repeat for 
Wednesday – Friday.  

9. Finally, delete the transitions on Saturday by right-clicking one 
transition at the time and select Delete in the popup menu. The 
template should resemble the one in Figure 2.62 on page 2:51. 

 
Figure 2.62 Schedule Template is now complete. 
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Figure 2.63 The Schedule Templates’s components. 

A few words about the schedule’s components. 

A week-based schedule template consists of 7 lines, one line for each day of the 
week. Each line corresponds to a time axis from 00:00 to 24:00. 

Green periods mean active time. Grey periods mean inactive time. The schedule 
is based on transitions between active and inactive periods. When we go from 
Sunday to Monday, the status is determined by the Initial State. 

The status of periods, i.e., whether they are active or inactive, depends on the 
transition that precedes a period. There are two types of transition, red (off), 
which indicates a transition to an inactive period, and green (on), which indicate 
a transition to an active period. 

There are different ways of changing the times in a schedule. Existing 
transitions can be moved by dragging with the mouse. It is possible to drag to a 
different day by dragging the transition “over the edge” of the time axis. Please 
note that it is not possible to drag a transition past another transition. You can 
also right-click a transition and select Set time… in the popup menu. 

You can also add brand new transitions by right-clicking a period and selecting 
Add transition on or Add transition off in the popup menu. In the same popup 
menu, you can choose to add a full period, i.e., with both an on and an off. 

To completely remove a transition, right-click the transition and select Delete in 
the popup menu. 

Creating a schedule from a schedule template 

When we are happy with our schedule template, it is time to create a schedule 
from the template. You can create several schedules from the same template if 
you want. Each schedule can then have its own unique deviations. We will look 
more closely at deviations a little later in this exercise. Now we will just create a 
schedule from our NormalTemplate. 

1. In the Ethiris Server’s configuration treeview, open the Schedule 
definitions node. 

2. Double-click the Schedules node in the treeview to open the 
Schedules panel. 

 Add new schedule 3. Click the Add a new schedule tool button in the toolbar. 

4. In the list, enter NormalSchedule in the Name column. 

5. In the treeview, under the Schedules node, a new item, 
NormalSchedule is created. Double-click this item to open the 
panel for this schedule. If there is more than one template, you 
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may have to change the Schedule Template to NormalTemplate in 
the list of templates as the first template is selected as default. It 
should look like Figure 2.64 on page 2:53.  

 
Figure 2.64 When creating a new schedule, the first template is automatically selected. 

Linking the schedule to a camera 

When we have created a schedule, we can use the associated input signal in 
various expressions for the system’s outputs. In this case, we will use the 
schedule to control when live video is sent from our camera Door. 

1. Open the Script panel in Ethiris Admin. It is located under the 
Logic node in the treeview. 

2. At this point, the script editor window should be empty. Open the 
Variable Browser panel by holding the mouse pointer over the 
corresponding tab to the right of Ethiris Admin. Locate and select 
the camera Door in the Variable Browser panel, see Figure 2.65. 
Double-click on the signal Enable to copy this signal to the script. 

3. Manually enter an equal sign, “ = ” after Door.Enable in the script. 

4. Locate and select the NormalSchedule object under the Schedules 
node in the Variable Browse panel. Double-click the Active signal 
for the schedule to copy it to the script after the equals sign. 

5. End the line with a semicolon. The script should look as in Figure 
2.66 on page 2:54. 
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Figure 2.65 Variable Browser in Script with camera Door selected. 

 

 
Figure 2.66 Schedule linked to the camera Door. 

So far, we have not yet saved the new configuration and Ethiris Server knows 
nothing about the schedule and when to enable live video from the camera.  

Before we send the new configuration to the server, we will look at the live 
video from the camera Door in Ethiris client. Start the client and select the live 
part to look at the live video from the camera Door. Verify that video is being 
displayed. 

To send the new configuration to the server, click the save icon in the Ethiris 
Admin toolbar. 

When the server receives the new configuration and discovers that the camera 
Door is to be inactive according to the schedule, the video will disappear, and 
the text Camera Inactive! will be displayed instead. 
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Figure 2.67 Camera Door is inactive according to the schedule. 

 

Schedule deviations 

A week-based schedule applies week after week, and a day-based schedule 
applies day after day. However, not all weeks may be the same. There may be a 
public holiday or some particular work that alters the standard working 
schedule. 

For these cases, you can add deviations to the normal schedule. A deviation is a 
schedule that applies to a specific week or day. There are two types of 
deviations.  

We call the first Default deviation. This is in the treeview under Deviations. A 
default deviation is available for all schedules. For each schedule, you can select 
whether default deviations are to be obeyed. It may be suitable here to insert, 
for example, Christmas week and Easter week. 

The other type of deviation is specific to a specific schedule. A specific deviation 
is defined under the current schedule in the treeview. This type of deviation 
applies only to the schedule for which it is defined. 

In our example, we will create a schedule, LiveSchedule, which has a deviation 
with an active period of time right now. The aim is to get live video from the 
camera Door even if the schedule template NormalTemplate is inactive. The 
effect will be that we can look at live video thanks to the deviation schedule, 
but recording remains deactivated via the normal schedule. So, even if motion 
occurs in front of the camera, no recording will start. 

To achieve only this effect, it would have been simpler to remove the 
NormalSchedule.Active input signal from the camera Door’s expression for live 
video, but again, this is for the sake of the exercise. 

1. Select the Templates node in the treeview. 

2. This time we will use the popup menu to create a new schedule 
template. Most commands are available from several different 
places, the menu, the toolbar, and the popup menu. 
Right-click the Templates node in the treeview. A popup menu is 
displayed. 
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3. Select New->Template in the popup menu. A new template called 
New Template (or New Template 3 if you have followed all 
instructions up till now) is created in the treeview. 

4. Double-click the new template in the treeview to open its panel. 

5. Enter the name LiveTemplate in the Name text box. The name is 
immediately updated in the treeview as well. 

6. Select type Day. 

7. Ensure that there is an active period that extends at least from 
now and 15 minutes into the future so that we can look at live 
video. 

8. We will now create a schedule called LiveSchedule, which looks just 
like the NormalSchedule schedule.  

9. Right-click the Schedules node in the treeview and select New-
>Schedule in the popup menu. A new schedule called New 
Schedule is created in the treeview. 

10. Double-click the new schedule in the treeview to open its panel. 

11. Enter the text LiveSchedule in the Name text box. Change Schedule 
Template to NormalTemplate. So far, this schedule is the same as 
NormalSchedule, and it uses the NormalTemplate. 
We will now add a deviation specific to this schedule. 

12. In the treeview, under the new schedule, LiveSchedule double-
clicks the Deviations node to bring up the Deviations panel for this 
schedule.  
 

13. In the Deviations panel, click the Add a new deviation button. A 
new item is created in the list. 

14. Enter the text DoorDeviation in the Name column. 

15. Double-click the new deviation in the treeview to open its panel. 

16. In the Use this template… frame, select Schedule Template: 
LiveTemplate. 

17. In the During this period… frame, select Date, and enter the 
current date under Month and Day. The panel should look 
something like Figure 2.68 below. 
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Figure 2.68 New deviation created. 

18. We will now change the expression for displaying live video for the 
camera Door. 
Open the Script panel. 

19. Change the expression to the right of the equals sign for the Enable 
signal to LiveSchedule.Active. 

Ensure again that you do not have live video viewing enabled in Ethiris Client. If 
everything is right, the image should display the text “Camera Inactive!”. 

Now save the new configuration to the server by clicking the save icon in the 
Ethiris Admin toolbar. 

Hey presto, there should be live video from the camera Door again. 

Try to create motion in front of the camera that would normally start recording. 
As the normal schedule, which has no deviation, still applies as the expression 
for event recording, this should not happen now. 

However, manual recording works even if the schedule is inactive. 

For the sake of completeness, let us also create a default deviation for 
Christmas week 2012. We find that Christmas Eve falls on a Monday and 
Christmas Day and Boxing Day on Tuesday and Wednesday in week 52. We 
assume that most people are off work on these three days. We will now make a 
schedule template that is active for all of Monday, Tuesday, and Wednesday 
but otherwise follows the default times. 

20. Right-click the Templates node in the treeview. 

21. Select New->Template in the popup menu. 

22. Double-click the new template in the treeview to open the 
corresponding panel. 

23. Enter the name ChristmasTemplate 2012 in the Name text box. 

24. Create appropriate inactive periods for Thursday – Friday. Remove 
transitions for Monday – Wednesday and Saturday. You can copy 
Sunday to these days. The schedule template should look as in 
Figure 2.69 below. 

 
Figure 2.69 Schedule template for Christmas week 2012. 
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25. Right-click the Deviations node directly under the Schedule 
definitions node in the treeview and select New->Deviation. 

26. Double-click the new deviation in the treeview to open the panel. 

27. Enter the name ChristmasDeviation in the Name text box. 

28. In the Use this template… frame, Select ChristmasTemplate 2012 in 
the selection list for Schedule Template. A mini image of the 
schedule template selected is displayed. 

29. In the During this period… frame, select Week 52. See Figure 2.70 
below for an example of how it might look. 

 
Figure 2.70 Deviation schedule for Christmas week. 

The last step is to specify that the NormalSchedule schedule is to use default 
deviations. It is, of course, possible to create several weeks with default 
deviations. If you select a schedule so that it obeys default deviations, it obeys 
all default deviations that are defined under Default deviations in the treeview. 

30. Open the schedule panel for the NormalSchedule schedule, by 
double-clicking the schedule in the treeview. 

31. Confirm that the checkbox Obey default deviations is checked. 
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Figure 2.71 The schedule obeys default deviations. 

To send the new configuration to the server, click the save icon in the Ethiris 
Admin toolbar. 

What have you learned? 

Task 3 is now complete. In this task, you have learned how to use schedules to 
limit live video viewing and recording of events. 

You can freely define several different week-based or day-based schedule 
templates. Using the templates, you create schedules. The same template can 
be used several times. Each schedule created automatically generates an input 
signal with the name Active. These signals can be used to control when various 
functions in Ethiris are to be active, for example when live video may be 
displayed or when video from a camera may be recorded. 

It is possible to define deviations from ordinary schedules. It is also possible to 
define deviations that are specific to one schedule. You can also define default 
deviations that can be applied to any schedule. 

In the next task, we will look at how to set up automatic deletion of old video. 
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Task 4, Deleting Video 

This task will teach us how to delete old video. 

Instructions, Automatic Deletion of Video 

The automatic deletion of video is defined in the server configuration. If Ethiris 
Admin has not yet been started, start it now. 

There are two types of recorded video in Ethiris. The video has been recorded 
either in connection with an event or as continuously recorded video. 
Regardless of how the video has been recorded, the video is stored on disk in 
the same way. As a consequence, the automatic deletion of video is defined 
once for each camera. 

Already in task 1, we saw that you can define a global setting for automatic 
deletion of old video that applies for all cameras in Ethiris Server. If you want, 
you can make exceptions from the global setting for specific cameras. 

Defining automatic deletion of old video 

We will now configure the server so that video more than 3 days old are 
automatically deleted.  

To begin with, we will use the global setting. 

1. Double-click the Storages node in the treeview for the server 
configuration.  

2. In the frame Clean up video – Global setting for all cameras, ensure 
that the checkbox Delete old images automatically is checked.  

3. Set 3 in the Days box. 

4. Set 0 in the Hours and Minutes boxes. The panel now should look 
as in Figure 2.72. 

To send the changes to the server, click on the Save-icon in the toolbar in Ethiris 
Admin. Old video is checked twice a minute automatically. 

 
Figure 2.72 Global setting to delete video more than 3 days old for all cameras. 

If you have followed this manual to the letter, there should remain a specific 
setting for the camera Door that overrides the global setting. We sat automatic 
deletion of old video to 1 hour. There is a simple way to check which cameras 
that respect the global setting and which have specific settings. 
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1. Beneath the node Storages in the treeview is the node Default, 
double-click this node to open the corresponding panel.  

In this panel, there is an overview of the recording settings for all cameras that 
uses this storage. In Figure 2.73, an icon is marked. It is orange if the global 
clean up settings are overridden by this camera. If the global settings are 
respected, the icon is green. 

You can also see the time for the oldest and newest recording, respectively for 
each camera. 

 
Figure 2.73 Overview of the storage for the cameras on storage Default. 

As mentioned earlier, it is possible to set the clean up time for video individually 
for each camera. For the sake of practice, let’s assume that we want the camera 
Door to delete old video after 5 days. 

1. In the treeview of the Ethiris Server’s configuration, double-click 
the Storage node for the camera Door to open the Storage panel. 

2. Ensure that the checkbox Override storage Clean up setting is 
checked. 

3. In the Clean Up frame, ensure that the Delete old images 
automatically checkbox is checked. 

4. Enter 5 in the Days box. 

5. Enter 0 in the boxes for Hours and Minutes. The panel now should 
look as in Figure 2.74. 

To update the server, click the save icon in the Ethiris Admin toolbar. 



Getting started with Ethiris Getting Started 

 Task 4, Deleting Video  

 2:63  

 
Figure 2.74 Setting for the camera Door to delete video more than 5 days old. 

What have you learned? 

In task 4, you have learned how to set up automatic video deletion from the 
hard disk and how to view an overview of the recording settings for all cameras 
at the same time.  

In the next task, we will learn how to send emails and SMS with Ethiris. 
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Task 5, Email and SMS 

Even if you are not at an Ethiris Client, you can be notified of important events. 
It is possible to receive a message via email and SMS on selected occasions. 

In this task, we will learn how this works. 

Instructions, Sending Email 

Email management is entirely defined in the server configuration. If Ethiris 
Admin has not yet been started, start it now. 

You can create the desired number of email definitions in the Ethiris Server’s 
configuration. Each definition has its own unique name, its own unique text, 
and its own unique recipients. 

Each email definition created in the Ethiris server configuration automatically 
generates an associated digital output in the Ethiris data store. Each time this 
digital output is enabled (set to true), an email message is sent. By defining 
suitable logical conditions, you determine when the output will be enabled. Of 
course, you also can define a button in Ethiris Client and connect the button to 
the email send signal for sending an email on button click in the client. 

In this example, we will define two different email messages. We will use one of 
them to state that we have a communication error in our camera, and we will 
send the other when there is motion in front of the camera at times specified in 
the NormalSchedule schedule. 

Email is configured in a number of steps. The first step involves creating your 
contacts, i.e., potential recipients. This is done in the form of Ethiris users. 
However, they do not have to be full-fledged users that can be used to login to 
Ethiris. These are common to both email and SMS. 

We will create two contacts and an address list. 

Use a valid email address for 
this test. 

We will start by creating a list of recipients. In our example, we will create 
test@kentima.se and test@ethiris.se as recipients. Use an address of your own 
that can function as a test in this exercise. 

1. In the treeview, under Obelix, there is a node called Security. 
Expand this node and double-click on the Users node to open the 
Users panel. 

2. In the Users panel, click the Add a new user button to add a new 
contact. A new item is created in the list with Name, In use, User 
name, Email, and SMS columns.  

3. Enter KentimaTest in the Name column. This is used as a reference 
in any address lists and when recipients for email messages and 
SMS are to be selected. You can choose a different name if you 
want. 

4. We do not want to use this user definition to log in, so we can 
leave the In use checkbox unchecked and the Username column 
empty. 

5. Enter test@kentima.se in the Email box. Again, this is only an 
example. You can use another suitable address. Remember that 
there must be a “@” sign in the address for it to be accepted. 

6. Leave SMS blank for now. 
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7. Repeat items 2 – 5 for another recipient, EthirisTest, with the 
address test@ethiris.se. 

8. For an example of what the panel may look like so far, see Figure 
2.75.  

 
Figure 2.75 Example of a list of recipients. 

We will now also create a contact list called AllTest. 

1. In the treeview under Notifications, double-click the Contact Lists 
node to open the panel. 

2. In the Contact Lists panel, click the Add new contact list button. A 
new item is created in the list. 

3. Enter AllTest in the Name column for the new item. 

4. In the treeview, a new item has been created under the node 
Contact Lists; double-click the node AllTest in the treeview to 
open the panel. 

5. In the AllTest panel, check both KentimaTest and EthirisTest to 
mark them as selected contacts in the list. 

6. The dialog should now look something like Figure 2.76. 
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Figure 2.76 Contact list created. 

OK, the next step is to enter general details for sending emails.  

1. In the treeview under Notifications, double-click the Mails node to 
open the Mails panel. 

2. In the Mails panel at the top, enter Ethiris as the Sender Name. 
This is displayed as the sender in all email messages. You can use a 
different sender name if you want. 

3. Enter obelix@ethiris.se in the Sender Address box. Again, this is just 
an example. You can use a different address if you want. 
Remember that there must be a “@” sign in the address for it to 
be accepted. 

4. In the SMTP Server box, enter the name of the email server used 
for outgoing mail. In a company, you probably have a local server 
for this, for example, an Exchange server. The network 
administrator at the company should be able to tell you what 
name to enter here. At home, you may have an Internet Service 
Provider, which can tell you what the email server is called. In our 
example, we enter smtp.ethiris.se. This does not work in reality. 

5. The SMTP Port is 25 by default but can be changed if necessary. 

6. Most email servers require a User name and Password. Enter them 
if needed. 

7. The panel may look something like Figure 2.77 below.  
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Figure 2.77 General email settings entered. 

Now it is time to define our two email messages. Keep the panel for Mails open. 
Our first email message will be used if we have a communication error with the 
camera Door. 

1. Click the Add Mail button, below the general settings, to add an 
email message. The Name, Subject, and Priority fields can be 
entered directly in the list. To be able to enter all required 
information, the mail has to be opened in its own panel. 

2. In the treeview under Mails, double-click the New Mail node to 
open the panel. 

3. Enter ErrorCameraDoor in the Name box. This name is used as the 
name of the digital output signal that is automatically created for 
an email message in Ethiris. 

4. Enter Communication error with the camera Door in the Subject 
box.  

5. Select High as the priority. 

6. Enter Ethiris has detected an error in communication with the 
camera Door in the Body box. 

7. Select appropriate recipients of the mail by checking the 
corresponding checkbox. In our example, we use the contact list 
AllTest.  

8. Check the Attachment for camera Door. Even though there is a 
communication error, the last image sent from the camera will be 
attached to the email, which might be of interest. The panel now 
looks roughly as in Figure 2.78 below. 
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Figure 2.78 An email message for the communication error has been defined. 

Now we will define the second email message, which will be sent in the event 
of motion in front of the camera Door. 

1. Switch back to the Mails panel. Click the Add Mail button to add 
another email message.  

2. Double-click the New Mail node in the treeview. 

3. In the New Mail panel, enter MotionCameraDoor in the Name box. 
This name is used as the name of the digital output signal that is 
automatically created for an email message in Ethiris. 

4. Enter Motion in front of the camera Door in the Subject box.  

5. Keep Normal as the Priority. 

6. Enter Ethiris has detected motion in front of the camera Door in the 
Body box. 

7. Select appropriate recipients of the mail by checking the 
corresponding checkbox. In this example, we use the contact 
KentimaTest.  

8. In this case, it may be worth attaching a frame. Select the camera 
Door by checking the checkbox in the Attachments frame. The 
panel now looks as in Figure 2.79 below. 



Getting Started Getting started with Ethiris  

Task 5, Email and SMS   
 

2:70 

 
Figure 2.79 Email message for detected motion. 

The last step is to tell Ethiris when the email messages are to be sent. 

1. Open the Script panel by double-clicking the Script node in the 
treeview. 

2. We will start with the message for the communication error with 
the camera. 

3. In the script, enter a couple of new lines at the end of the script. 
You can enter comments by using a double slash “//”. This makes 
reading the script easier and can also serve as documentation of 
the script. Enter a line with the following text: // Send mail on a 
communication error. This text appears in green. Press enter to 
create a new line. 

4. In the Variable Browse panel a new node, Mail, has appeared. Click 
the + sign before Mail to display the email messages that are 
defined. 

5. Select the mail ErrorCameraDoor.  

In the lower pane, double-click the Send signal. The signal is 
copied to the current location in the script.  

// Send mail on a communication error 

ErrorCameraDoor.Send 

6. Enter an equals sign, “ = ” after ErrorCameraDoor.Send. 

7. In the Variable Browser panel, select the camera Door under the 
Network Cameras node. 

8. In the lower pane, double-click the CommunicationError signal. 
The signal is copied to the current location in the script. 
Alternatively, you can drag and drop the CommunicationError 
signal to the script editor after the equals sign to select this input 
signal as a condition for the output signal Send.  

9. Finish the line with a semicolon, “;”. 
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10.  The text ErrorCameraDoor.Send = Door.CommunicationError 
should now be visible in the script editor. The script should look as 
in Figure 2.80. 

 
Figure 2.80 A communication error for the camera enables the transmission of an email 
message. 

1. We will now connect together the logic for our second message as 
well when we still have the script open.  

2. Enter a couple of new lines and a comment, like // Send mail on 
motion. 

3. In the Variable Browse panel, select the email message 
MotionCameraDoor. In the lower pane, the output signal Send is 
displayed. 

4. Double-click the Send signal to copy it to the script. 

// Send mail on motion 

MotionCameraDoor.Send 

5. Enter an equals sign, “ = “ after MotionCameraDoor.Send. 

6. In the Variable Browse panel, under the camera Door, there is a 
node called Motion Detections. Under this node, there is the 
motion detection Motion at door, select this object. 

7. In the lower pane, double-click the signal Motion. The signal is 
copied to the script. 

8. The idea is that this message should only be sent in connection 
with motion at certain times of the day. We will now combine 
motion detection with our schedule that we defined earlier. After 
the variable name Door.Motion_at_door.Motion in the script 
editor, enter a space, then && and then another space. Two & 
signs mean AND, and is used to combine two input signals. 

9. Locate the Schedules node in the Variable Browse panel. Click the + 
sign before the text Schedules. The schedules we defined earlier 
appear. 
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10. Select the NormalSchedule schedule. The input signal Active is 
displayed in the lower pane. 

11. Drag and drop the Active signal to the script editor after && to 
combine this input signal with the motion detection.  

// Send mail on motion 

MotionCameraDoor.Send = 

Door.Motion_at_door.Motion && 

NormalSchedule.Active 

12. Finish the line with a semicolon, “;”. The script should now look 
roughly as in Figure 2.81. 

 
Figure 2.81 Send an email if we have motion, and the schedule is active. 

We will test what we have configured for email so far. 

Click the save icon in the Ethiris Admin toolbar to send the new configuration to 
the server. 

Try to pull out the network cable for the camera Door. Provided that the various 
email settings are correct, an email message will be sent to the selected 
recipients after approximately 30 seconds. This is the default timeout for 
communication with the cameras. 

To test the second message, it is necessary for motion to be detected during 
the time that the NormalSchedule schedule is active. To avoid working in the 
evening or at the weekend, it is a good idea to change the schedule so that it 
becomes active right now. One way of doing this is to create a deviation for the 
current day. See section Task 3, Using Schedules on 2:48 for a complete 
description of the schedules. 

 

  Ensure that the schedule 
does not prevent alarm 
monitoring. 

Ensure that there is motion in front of the camera Door that triggers the alarm. 
Verify that an email message with the associated frame has been sent to the 
address(es) you specified in the recipient list. 

In the next section, we will look at the possibilities of sending SMS. 
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Instructions, Sending SMS 

This task requires a GSM modem from Westermo, GDW-11. 

In the example below, we assume that we have access to a SIM card with the 
code 1234. Insert this SIM card in the GSM modem according to the instructions 
supplied with the modem. Connect the modem to the computer running Ethiris 
server via a serial port. In our example, we assume that the modem is 
connected to port COM1. 

The first thing we need to do is to supplement the contact details we defined 
earlier for sending an email. We will now add a mobile phone number so that 
we can send SMS to one of these contacts. 

1. Start the Ethiris Admin if you have not already done so. 

2. Bring up the Users panel by double-clicking the Users node in the 
Ethiris Server’s configuration tree. Now. The current list of 
contacts is displayed in the panel. 

3. In the list of contacts at the left of the dialog, select KentimaTest. 

4. In the SMS column for the contact KentimaTest, enter a suitable 
mobile phone number, for example, 0705123456. 

The panel may look as in Figure 2.82. 

 
Figure 2.82 A mobile number is defined for one of the contacts. 

1. Open the SMSs panel by double-clicking the SMSs node in the 
treeview. 

2. Leave the Port as COM1. 

3. Leave the Baud rate as 115200, Data bits as 8, Timeout as 10000, 
Stop bits as 1, and Parity as N. 

4. Enter the PIN, for example, 1234. 

The dialog now looks roughly as in Figure 2.83. 
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Figure 2.83 General SMS settings have been entered. 

1. In the SMS list section, click the Add New SMS button to create a 
new SMS message. A new SMS is created. 

2. Enter SMSTest in the Name column. 

3. Enter Ethiris sends SMS in the Message column. 

4. Open the panel for the new SMS SMSTest by double-clicking its 
node in the treeview. 

5. Select KentimaTest as Receiver.  

6. The panel should now resemble the one in Figure 2.84. 

7. Click the save icon in the main toolbar of Ethiris Admin to send the 
new settings to the Ethiris server. 

 
Figure 2.84 SMS message has been created. 

To test our SMS function, we will add a button to the client. In a real situation, 
we would probably send an SMS as a consequence of some form of an alarm 
signal. For example, motion detection in combination with a schedule, in a 
similar manner to what we did for email. See Figure 2.81. However, to 
introduce another element into the exercise, we will do the following instead. 
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1. In the client configuration part of the treeview in Ethiris Admin, 
right-click on the node Section One and select New->Button->I/O 
in the popup menu. 

2. Enter SMS as the name of the button directly in the treeview. 

3. Double-click the new node SMS in the treeview to open the 
corresponding panel. 

4. Uncheck the checkbox Toggle button. 

5. Click the browse button to the right of the IO-signal box. In 
alphabetic order, you will find the signal SMSTest.Send. Select this 
and click the OK button. 

6. To save the new client configuration on the server, click the Save 
icon in the Ethiris Admin toolbar. 

 
Figure 2.85 Settings for the button for sending SMS have been entered. 

Finally, to test the SMS function, start Ethiris Client, and click the new SMS 
button. If everything is correctly set, an SMS should be sent to the selected 
recipient. 

What have you learned? 

In task 5, you have learned how to send email and SMS in connection with an 
alarm or other selected events. Ethiris flexible structure allows any available 
signals in the system to be combined to send email or SMS. We have only seen 
a few simple examples of how this may work. 

In the next task, we will learn how to use FTP to reduce the traffic on the 
network. 
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Task 6, Alarms via FTP from the Camera 

Ethiris normal working method is to continuously retrieve video from the 
cameras and video encoders connected to the server. The alternative is to put 
the camera in FTP mode. 

In version 5.8 of Ethiris, there is also a possibility to use so-called Video on 
Demand, which is selected in the panel Recording. This choice means that the 
Ethiris server does not retrieve video continuously unless a client requests 
video for live video viewing. For more information about video on demand, see 
the Admin manual. 

FTP mode means that the Ethiris server does not retrieve video continuously 
unless a client requests video for live video viewing. The advantage of this is 
that the network is not loaded unnecessarily. 

The disadvantage is that, as no video is retrieved continuously, it is not possible 
to use motion detection in Ethiris. Nor is it possible to buffer video in Ethiris for 
pre-alarm for an event recording. 

When you use FTP mode, and an alarm event occurs, the video has to be sent 
from the camera to Ethiris via FTP (File Transfer Protocol). The alarm must be 
defined in the camera or video encoder, together with the settings for the FTP 
transfer of the video. Furthermore, this function has to be activated in Ethiris 
Server. 

Not all camera models or video encoders support FTP or alarm detection. Some 
models have digital inputs that can be used to trigger an alarm. Some models 
have built-in motion detection that can be used as an alarm. Their common 
feature is that they have a more or less limited buffer for the number of frames 
that can be sent via FTP in the event of an alarm.  

In Ethiris, this buffer is relatively large and is determined principally by the 
primary memory in the computer. It is not possible to say in advance precisely 
how much memory is available to Ethiris as it depends on the other programs 
running on the computer.  

In our example, we will use a video server called Axis 241QA. 

 Instructions, Activate FTP in Ethiris Server 

Before FTP can be used, it has to be activated in Ethiris Server. 

1. Start Ethiris Admin. 

2. Double-click the node Obelix in the treeview. 

3. Select the tab FTP in the Ethiris Server panel. 

4. Check the checkbox Enable reception of video via FTP. 

5. Let 21 remain as FTP-port. 

6. If you want, you can change the Login name (Ethiris) and Password 
(Pass). 
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Figure 2.86 Activate FTP for Ethiris Server. 

Instructions, Settings in the Video Encoder 

When pressed, the 
pushbutton should connect 
inputs 2 and 3 on the green 
terminal block on the rear of 
the video server. 

We will use a pushbutton to simulate an alarm. An Axis 241QA has 4 digital 
inputs, and we will have input no. 1 set via an external pushbutton. When the 
alarm comes via the digital input, the video will be sent via FTP to Ethiris. The 
video will be saved at a rate of 5 frames per second (0.2 seconds between 
frames), and we will send 20 frames before the alarm and 10 frames after the 
alarm. 

In this exercise, we assume that an analog camera has been connected to video 
input no. 1 on the video server. Later in the exercise, we will add the video 
server to our configuration, but first, we will make the necessary settings in the 
video server. 

We need to make several settings directly in the video server. For this, we use a 
standard web browser such as Internet Explorer. 

1. Start your web browser and enter the IP address of your Axis 
241QA video server, for example, 192.168.31.25. Log on, if 
necessary. 

2. Select Setup at the top right. Log on, if necessary. 

3. To the left is a menu. Select Event Configuration. 

4. In the submenu, select Event Servers. 

5. Click the Add FTP… button. 

6. Enter a Name, for example, Ethiris. 

7. For Network address, enter the IP address of the computer on 
which your Ethiris server runs, for example, 192.168.31.1. 

8. Leave the Upload path blank. 

9. Verify that the port number matches the setting in Ethiris under 
the FTP tab in the settings for the Ethiris server. This is 21 by 
default. 
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10. Enter the user name and password for the Ethiris FTP service 
according to the setting in Ethiris under the Alerts and FTP tab in 
the settings for the Ethiris server. By default, these are Ethiris and 
Pass. 

11. Leave the other settings as they are. 

12. It should look as in Figure 2.87. Click OK to save the new Event 
Server. 

 
Figure 2.87 Dialog in the video server for adding an Event Server. 

13. If everything has worked, a new line should have appeared on the 
list of Event Servers. See Figure 2.88. 

 
Figure 2.88 A new Event Server has been added to the list. 

14. Select Event Types in the menu to the left. 

15. Click the Add triggered… button. 
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16. Enter a Name, for example, Pushbutton. 

17. In the Triggered by…section, select Input ports. 

18. For Input 1, select Active. 

19. When triggered… section, check the Upload images checkbox. 

20. For Select upload type, select FTP. 

21. For Upload to FTP Server, Primary, select Ethiris. 

22. Check the Include pre-trigger buffer checkbox and select 5 
seconds. 

23. Select a Frame rate of 5 frames/second. 

24. Check the Include post-trigger buffer checkbox and select 2 
seconds. 

25. Select a Frame rate of 5 frames/second. 

26. Base File Name is important. This must display the Cam<ID>, 
where <ID> is a number that identifies the camera. As long as a 
camera has been added in Ethiris Admin and then saved to Ethiris 
Server, there is a unique ID for the camera. This ID can be found in 
the camera’s general settings panel. Just double-click on the 
camera node in the treeview for the Ethiris Server’s configuration. 
See Figure 2.89 on page 2:78 for information on where to find this 
ID. In this example, we assume that the camera has ID=3577. To 
avoid any problems with figures in the file name after the base 
name, we add an underscore after the base file name. It is then 
Cam3577_. 

 
Figure 2.89 The camera ID is displayed in the camera’s general settings panel. 

27. Check the Use event-specific image settings checkbox. 

28. Leave all other settings as they are. 

29. It should look as in Figure 2.90. Click OK to save the new Event 
Type. 
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Figure 2.90 Dialog for adding a Triggered Event Type. 

30. If everything has worked, a new line should have appeared in the 
list of Event Types. See Figure 2.91. 
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Figure 2.91 A new Event Type has been added to the list. 

We have now finally finished the settings in the video encoder, and you can 
close the web browser. 

Instructions, Adding a Video Encoder 

As mentioned in the previous section, the camera ID must be included in the 
image name for the frames sent via FTP from the camera. This is so that Ethiris 
can work out which camera the frames belong to. 

As we have not added the camera (video encoder) to the server configuration, 
we will do so now. 

7. Start the Ethiris Admin. 

8. In the treeview under Obelix, double-click the Cameras node. 

 Add camera 9. Click the Add a camera button. A new item is created in the 
cameras list. 

4. Enter the Name FTPTest. 

5. Select Manufacturer Axis Communications. 

6. Select the Type [Probe]. 

7. Enter the correct IP Address, for example, 192.168.31.25. 

8. Enter the Login and Password selected for the video encoder. 

9. Select the whole line with the new camera and click the Refresh 
camera tool button. 

10. It may look as in Figure 2.92.  
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Figure 2.92 Panel for adding a new video encoder. 

The new video server has now been added to the treeview.  

As mentioned earlier, we assume that the analog camera is physically 
connected to video input no. 1 on the video encoder. 

1. Leave the Channel as 1. 

2. Leave Protocol unchanged as MJPEG – Server push. 

3. In the treeview, a new node has been created under the Cameras 
node. Double-click this node FTPTest in the treeview to open the 
Camera panel. Check the FTP Mode box. This tells Ethiris that 
video is not to be retrieved continuously. If an alarm is detected in 
the camera/video encoder, the camera/video encoder will send 
video via FTP, and this is interpreted as an alarm by Ethiris, which 
will then create a record event that is displayed in the event list, 
and the recording is indicated in the timelines with red color. 

4. The Delay Transfer box must also be checked in this case. This is 
because we selected Include post-trigger buffer in the settings for 
Event type in the video server. Delayed transfer specifies that the 
camera/video server does not send video via FTP until all video in 
the camera/video server, i.e., both the video in the pre-alarm 
buffer and those in the post-alarm buffer. Ethiris uses this 
information to calculate the time of the alarm. 

5. See Figure 2.93 for an example of what the panel should look like. 
Notice the ID and update the Pushbutton settings in the Event 
Type List for the video encoder if necessary. See Figure 2.90 on 
page 2:79 for an example of how the dialog looks like. 

 
Figure 2.93 New camera with FTP mode selected. 
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6. Open the Storage panel for the new analog camera by double-
clicking the Storage node in the treeview under the new camera. 

7. It is important that the values for frame rate and the time before 
and after an event matches those selected in the camera settings 
in section Instructions, Settings in the Video on page 2:75. This 
information is used by Ethiris to calculate the time of the event. 
Enter Frame rate 5 per second, Time before 5, and Time after 2. 
See Figure 2.94 for an example of what it should look like. In this 
exercise, Min. storage (MiB) is not essential. Just ensure that it is 
sufficiently high to allow space for at least a few hundred frames. 
Please note that no expression for recording events needs to be 
entered in this case. The alarm detection is in the video server.  

 
Figure 2.94 Settings for video storage. 

8. Click the save icon in Ethiris Admin to send the new configuration 
to the server. 

 

NB. Again, if the ID of the new camera is not 6837, the Base file name in the 
video server has to be changed so that the name matches the Cam<ID>_. See 
Instructions, Settings in the Video  on page 2:75. 

All necessary settings in the camera and the server configuration should now be 
in place. 

To be able to see more than just the event in the event list in the Ethiris Client, 
add the new camera to the client configuration. 

1. In the client configuration’s treeview in Ethiris Admin, double-click 
the Obelix node under the Used Servers node. In the panel, check 
the new camera FTPTest. See Figure 2.95. 
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Figure 2.95 Add the new camera to the Ethiris Client configuration. 

To test, generate an alarm by pressing the pushbutton. After approximately 2 
seconds, an alarm should appear in the event list. 

If everything works as expected, a new event should appear in the event list in 
Ethiris Client, each time the push button is pressed. 

 
Figure 2.96 The FTP event appears in the Ethiris Client event list. 

Simply double-click the event in the list to load the video player with the 
corresponding camera and time. 

NOTE!. If the computer on which the Ethiris server is running has a firewall 
enabled, it may be necessary to open port 21, which is used to send files via 
FTP. In the video server in the dialog for Event Server settings, there is a button 
for testing the FTP server. In this case, the FTP server is the Ethiris server. 
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What have you learned? 

In task 6, you have learned how to use FTP to generate an alarm from a camera 
or a video encoder. 

This has the advantage of producing less strain on the network. The 
disadvantages are that the frame buffer is limited and that it is not possible to 
use Ethiris motion detection. 

In the next task, we will learn how to disable cameras that are currently not 
physically connected. 
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Task 7, Disabling Cameras 

In some instances, it may be practical to be able to configure a camera even if it 
is not physically connected to the system. This may be the case if you have 
several cameras that are moved around in an installation.  

Let us say that you have 10 locations where you want to film, but only 6 
cameras. You can configure 10 cameras and only enable the 6 cameras that are 
currently connected. If you want to move camera 1 to location 7, you disable 
camera 1 in the Ethiris Server’s configuration and enable camera 7 instead. This 
means that you do not need to reconfigure the cameras every time they are 
moved. There may, of course, be a lot of settings for each camera, such as 
alarm conditions and the like. 

In this task, we will disable the camera FTPTest, which we added in the previous 
task, and see what consequences this has in the client. 

Instructions, Disabling a Camera 

If Ethiris Admin has not yet been started, start it now. 

1. Open the panel for the camera FTPTest by double-clicking the 
camera in the Ethiris Server’s configuration tree. 

2. Uncheck the Camera in use checkbox. 

3. The panel should look as in Figure 2.97.  

 
Figure 2.97 Camera disabled. 

Click the save icon in the Ethiris Admin toolbar to save the configuration to the 
Ethiris server. 



Getting Started Getting started with Ethiris  

Task 7, Disabling Cameras   
 

2:88 

 

Instructions, a Disabled Camera in the Client 

If Ethiris client has not yet been started, start it now. 

1. Bring up the Cameras panel, by holding the mouse pointer over the 
Cameras panel’s tab in the bottom left corner of Ethiris Client. The 
panel slides open. Disabled cameras are displayed in a grey, 
disabled manner. See Figure 2.98.  

 
Figure 2.98 The camera FTPTest indicates that it is disabled. 

2. Select the disabled camera and then click the Show in Default Live 
Panel button. See Figure 2.99 

 
Figure 2.99 View a camera Live by selecting it in the Cameras panel. 

No live video is displayed, but only a message that the camera is disabled. See 
Figure 2.100. 
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Figure 2.100 A disabled camera live. 

What have you learned? 

In task 7, you have learned how to disable cameras that are currently not 
connected. 

In the next task, we will learn how to use logon to enhance security. 
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Task 8, Security 

There may be a need to limit user operations in Ethiris. For each user operation, 
you can, if you want, specify that the user who performs the operation must be 
a member of a certain user group in the Windows user system. This may be 
either a local user group on the computer running Ethiris Server or a global user 
group in a domain or Active Directory if the computers and users involved are 
members of a domain or AD. To be able to specify a user group in the domain, it 
is necessary for both the computer running Ethiris Server to be a member of the 
domain and the logon entered by the user to be for an account in the same 
domain. 

No logon at all is required by default. Anyone can use Ethiris. 

To access functions in Ethiris that requires a login, the user has to explicitly log 
on to the Ethiris Server where the privilege is defined. A user can logon both in 
Ethiris Client and in Ethiris Admin. The user enters a user name and password, 
after which Ethiris Server checks the password against the user name entered 
and checks that the user is a member of the group specified as a requirement in 
connection with the logon. 

Ethiris can validate login and privileges in three different ways, and these can 
also be mixed: 

 Log in as an Ethiris user. Users and user groups are created in Ethiris 
Admin, and validations of privileges are done against Ethiris user 
groups defined in the Ethiris Server configuration. 

 Log in as a local Windows user. Users and user groups are 
administered using tools from the Windows control panel. Validation 
of privileges is done against Windows user groups defined on the 
server running Ethiris Server. 

 Log in as a domain user. If the computer running Ethiris Server is a 
member of a Windows domain validation of privileges can be done 
against the users/user groups in the domain or Active Directory. These 
are administered by a Windows domain administrator. 

Note! Full security functionality requires an Advanced license level in Ethiris. For 
all license levels, though, you can set a password for starting Ethiris Admin. You 
can also set privilege for Show player in client, Show event list in client and Show 
alarm list in client. This means that for all license levels it is possible to control 
who can see and change configurations in Ethiris Admin and also who can see 
recorded video, events, and alarms in Ethiris Client. 

In this task, we will add two local Windows user groups, one for administrators 
and one for standard users. We will then create two Windows users, one 
administrator, and one standard user. 

Instructions, Creating Groups and Users in Windows 

1. Open the Computer management dialog. This dialog is under 
Control panel\Administrative tools. It can also be opened by right-
clicking Computer in the Start menu and then selecting Manage in 
the popup menu. 

2. Select the Computer management (local)\System tools\Local users 
and groups\Users node. See Figure 2.101. 
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Figure 2.101 Users in the Computer management dialog. 

3. Right-click Users and select New User… in the popup menu. 

4. Enter EthirisAdmin in the User name box. Enter a suitable 
Description. Select a Password and enter it again in Confirm 
password. Uncheck User must change password at next logon. 
Finally, check Password never expires. For an example of what it 
may look like, see Figure 2.102. Click the Create button to save the 
new user. Then click Close to close the dialog. 

 
Figure 2.102 Dialog for adding a Windows user. 

5. In the Computer management dialog, right-click Groups and select 
New group… in the popup menu. 
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6. Enter EthirisAdmins in the Group name box. Enter a suitable 
Description. 

7. Click the Add… button to add the user EthirisAdmin. 

8. In the Select Users dialog, click the Locations… button. Select the 
computer on which the Ethiris server is installed. In our example, 
this computer is called NEREID. 

9. Enter the name EthirisAdmin in the Enter the object names to 
select box. See Figure 2.103. 

 
Figure 2.103 Dialog for adding a user to a group. 

10. Click the Check Names button. If the name entered is found at the 
specified location, the dialog will look roughly like Figure 2.104.  

 
Figure 2.104 User name verified. 

11. Click OK to add the user to the group. 

12. The dialog should now look as in Figure 2.105. Click the Create 
button to save the new group. 



Getting Started Getting started with Ethiris  

Task 8, Security   
 
 

2:94 

 
Figure 2.105 Dialog for adding a new group in Windows. 

13. Repeat points 2 – 12 above to create a user called EthirisUser and a 
group called EthirisUsers. Add both the user EthirisUser and the 
user EthirisAdmin to the group EthirisUsers. This makes sense 
since an Ethiris administrator should be able to execute all 
operations that an Ethiris user can. 

We have now created a group of administrators, EthirisAdmins, and a group of 
regular users of Ethiris, EthirisUsers. 

We have also created a user that administrators of Ethiris must use when 
logging on, EthirisAdmin, and a user that regular users must enter, EthirisUser. 

In the Ethiris server configuration, we will now limit the rights to updating the 
server configuration to users who are members of the EthirisAdmins group. We 
will also restrict the viewing of live video to users who are members of the 
EthirisUsers group. 

Instructions, Security in Ethiris 

1. Start Ethiris Admin. 

2. In the Ethiris Server’s configuration tree, under the server Obelix, 
expand the Security node and double-click the node Privilege to 
open the Privilege panel. 

3. Locate the Update Server Configuration item on the list. 

4. Click the button to the right of the Required user group text field 
for the Update Server Configuration item. See Figure 2.106. 
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Figure 2.106 Click the Browse button to select a user group. 

5. In the Browse for User Group dialog, select the Local users on 
<computer name> tab.  

6. Select the name EthirisAdmins in the list of user groups. 

7. Click Select to add the name to the Required user group text field.  

8. Check the Audit checkbox. This means that the system will save 
information on the time, the operation performed, who 
performed it, the client computer from which it was performed, 
and any other available information, depending on the operation 
performed. 

9. The panel should look as in Figure 2.107.  

 
Figure 2.107 Security settings in the Ethiris server’s configuration with Update server 
configuration selected. 

10. Repeat points 4 – 8 to add EthirisUsers as a required user group 
for the user operation Show camera. 

11. The panel should look as in Figure 2.108.  
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Figure 2.108 Security settings in the Ethiris server configuration with Show camera 
selected. 

Click the save icon in the Ethiris Admin toolbar to save the new configuration to 
the Ethiris server. 

The next time the server configuration is saved, the login dialog is displayed. 
See Figure 2.109. 

 
Figure 2.109 Ethiris logon. 

You can also log on explicitly to one or several Ethiris Servers. In Ethiris Admin, 
right-click on the Ethiris Server in the treeview and select Log in in the popup 
menu. See Figure 2.110. 

 
Figure 2.110 Explicit log on in Ethiris Admin. 
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In the log in dialog, status is displayed whether someone is already logged in to 
the server(s). See Figure 2.111. 

 
Figure 2.111 Log in dialog with someone already logged on to the Ethiris Server Obelix. 

If you have logged on as a standard user, i.e., a user belonging to the 
EthirisUsers group and not EthirisAdmins, you will need to log on again if you 
want to save the server configuration. 

In Ethiris Client you log on to one or several Ethiris Server by clicking the Log in 
button in the Ethiris Client toolbar. See Figure 2.112. The log in dialog looks the 
same as it does when logging in via Ethiris Admin. 

 
Figure 2.112 Log in button in Ethiris Client. 

 

What have you learned? 

In task 8 you have learned how to use Windows groups and users to enhance 
the security in Ethiris. 

In the next task, we will learn how to troubleshoot Ethiris by using the logs in 
the system. 
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Task 9, Troubleshooting 

We hope that this section will not need to be read very frequently.  There 
may, of course, always be circumstances in which errors occur. 

Severe system errors are automatically displayed as alarms in each Ethiris 
Client. Such errors can, for instance, be a communication error with cameras, 
access failure of storage, or Script runtime errors. 

Whenever an alarm is active, this is clearly indicated in Ethiris Client by a 
flashing warning sign. In Figure 2.113, there is a communication error with the 
camera. This is indicated both in the live image and by the flashing warning 
sign. 

 
Figure 2.113 Active alarms are indicated in Ethiris Client by a flashing warning sign. 

Active alarms are displayed in the Alarm list. 

 
Figure 2.114 The Alarm list displays all active alarms. 
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Select one or more alarm(s) in the list and click the Acknowledge button to 
acknowledge the alarms. When there are no unacknowledged alarms left in the 
list, the warning sign stops flashing. When there are no alarms in the list at all, 
the warning sign disappears. 

 
Figure 2.115 The Acknowledge alarm button in Ethiris Client. 

There is also a log file for Ethiris Server that is stored on disk called 
EthirisServer.log. Ethiris Server also stores another five logs backward in time. 
These are called backlogs. These logs are called EthirisServer1.log, 
EthirisServer2.log, and so on. These log files log some system info at startup and 
then mainly log events that are considered not normal. 

In addition to these six logs in the server, it is possible to obtain a more detailed 
log, EthirisServerTrace.log. This log file is much more verbose and logs a lot of 
information about what is going on in the server. This file can be very helpful if 
something seems to not work according to your desires. 

All the logs are stored in the same directory as where EthirisServer.exe is 
installed. As a default on a 64-bit system, this directory is C:\Program Files 
(x86)\Kentima AB\Ethiris.  

There is no client tool for viewing the log files, but they can easily be opened in 
Notepad or other suitable text editors. 

EthirisServer.log is automatically created, and a backlog is created every time 
the Ethiris Server is restarted. The trace log, EthirisServerTrace.log, is nowadays 
active per default and is also created automatically. The setting for this can be 
found on the Log Files tab in the Ethiris Server panel in Ethiris Admin. 
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Figure 2.116 Settings for Trace logging in Ethiris Server. 

 

What have you learned? 

In task 9, you have learned about various alarms and logs in Ethiris. 

The server has one normal log and five backlogs. In addition to these, you have 
the trace log. That produces a very detailed log file. 

In the next task, we will learn how to use the control panel in Ethiris Client. 
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Task 10, Control panel 

It is possible to display a control panel in specific camera views in the client’s 
live part and also in the playback view in the client’s player. 

Instructions, Displaying the control panel 

We will start by displaying the control panel in our 1x1 live view that we call 
Door. 

1. Start Ethiris Client if you have not already done so. 

2. Select Live and the client view Door. 

3. Right-click anywhere in the camera view to open the menu. 

4. Select Always under Controlpanel visibility on the menu. See Figure 
2.117. 

 
Figure 2.117 Popup menu for a camera view in live. 

A control panel now appears at the bottom of the camera view. See Figure 
2.118 
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Figure 2.118 A control panel is displayed at the bottom of the camera view. 

We will now take a closer look at the components of the control panel. 

 
Figure 2.119 Maneuver panel in detail. 

Starting from the left, we have the following functions: 

Kamera name - frame 
rate  

  

The camera name is always displayed to the left. To the right of the camera 
name, the current frame rate is displayed. When the control panel is displayed 
in player views, instead of the frame rate, the timestamp of the current frame 
is displayed here 

 

Show/hide overlay on 
cameras  

  

Hides/shows overlay on cameras. This means that you can hide all items drawn 
on top of the camera image if they cover something in the image you want to 
see. What is hidden is the camera name, timestamp (in player views), and all 
interaction objects (buttons, LEDs, etc.). This button is shown both in live view 
and player views. 

 

Show camera in player 
Loads the current camera in the player. This button is only shown in live views. 

 

Maximize/restore view 
Is only visible if the view contains more than one camera view. Selecting the 
Maximize view menu item has the same effect as double-clicking the camera 
view. When active the camera view is enlarged to the whole view area, and 
when inactivated, the view is restored to the origin. This button is shown both 
in live view and player views. 

Freeze image 
Is used to simply freeze the current frame. Live video is temporarily stopped 
until Freeze image is released. When a camera is frozen, it is indicated by a 
flashing pause sign in the upper right corner of the image. It is also indicated by 
a tick mark to the left of the Freeze image menu item in the popup menu. The 
purpose of the freeze is to have better control over which image you get when 
you want to save or print an image from live video. This button is only shown in 
live views. 
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Instant replay 
Shows the current camera in an instant replay window. This button is only 
shown in live views. 

Talk 
Activates/inactivates the microphone and sends the audio the then connected 
audio devices of the current camera. This button is only shown in live views. 

Manual event recording 
Starts an event recording for the current camera. This button is only shown in 
live views. 

Search motion 
Opens the dialogue Search motion for the current camera. This button is only 
shown in player views. 

Export selection 
Opens the dialogue Export with the current camera and the current timespan 
selected. This button is only shown in player views. 

 

What have you learned? 

In task 10, you have learned how to use the control panel in Ethiris client.  

In the next task, we will learn how to use a PTZ camera, both in the Ethiris client 
and automatically via the Ethiris server.  
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Task 11, PTZ 

In this exercise, we will use a PTZ camera from Axis called P5534. This camera 

has a 360 pan function and 90 tilt function. The camera has an 18x optical 
zoom. 

The first thing we will do is to add the camera to our server configuration. For 
information on how to add a camera to Ethiris Server’s configuration, see Add a 
camera on page 2:16. 

NOTE!. Do not forget to select the right type of camera. If you select a type that 
does not have a PTZ function, these functions will not be available in the client.  

NOTE!. Do not forget to select the correct Rotation. Axis P5534 is a camera that 
is typically mounted upside down. This is considered to be Rotation = 0. In my 
case, however, the camera is located on a table and therefore needs to be 
rotated 180 degrees in the camera’s Picture Settings. 

 
Figure 2.120 The PTZ camera is rotated 180 degrees. 

When the camera is in the server configuration, all you need to do is select it in 
the client configuration as well.  

Instructions, Selecting a new camera into the client configuration 

1. After adding the PTZ camera to Ethiris Server’s configuration, do 
the following, in the Ethiris Client’s configuration tree, double-
click the Obelix node under the Used Servers node. The newly 
added P5534 camera should appear in the list of cameras. See 
Figure 2.121. 
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Figure 2.121 The list of available cameras in the client configuration contains a new 
camera. 

2. Check the Use column for the new camera P5534. Notice how the 
new camera appears in the configuration treeview, see Figure 
2.122. An alternative is to press the button “Sync cameras with 
server”. 

 
Figure 2.122 The new camera is selected in the client configuration. 

Now the new camera is available everywhere in Ethiris Client, e.g., in views and 
the Player. 

Feel free to create a new view containing the new camera. For instructions on 
how to do this, please refer to Creating a section and a view on page 2:24. 
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As default for a PTZ camera, optical mode is selected. You can toggle between 
optical/digital PTZ by right-clicking in the camera image and select Digital PTZ in 
the popup menu. 

Depending on which combination currently is selected, various PTZ operations 
are available. 

The following operations are available for PTZ cameras: 

Centre camera frame on mouse click – If you click with the middle mouse 
button in the frame, the frame is centered on the point you clicked. This works 
provided that you have not reached the limit for how much the camera can 
rotate. The command works both optically and digitally. 

Pan/tilt continuously when the left mouse button is held down – This command 
works only with optical PTZ. If you click and hold the left mouse button down in 
the frame, the camera is moved in the direction of the location of the mouse 
pointer in relation to the center of the frame. The further from the center the 
mouse pointer is, the faster the camera moves in that direction. When you let 
the left mouse button go, the camera stops moving. In digital mode and when 
the picture is zoomed in, you can drag the picture around by a click-drag-
release operation with the left mouse button. 

Zoom by drawing a rectangle – By drawing a rectangle with the right mouse 
button, you can zoom in on the area of the rectangle. The zoom takes place so 
that the entire area covered by the rectangle is displayed in the frame. This 
means that parts of the frame can be displayed even if they are outside the 
rectangle. The command works both optically and digitally. 

Zoom by scroll wheel – Zoom in by scrolling forwards and zoom out by scrolling 
backward. Each click on the scroll wheel is equivalent to one zoom step. The 
command works both optically and digitally. 

Zoom continuously by clicking and holding the middle mouse button and 
moving the mouse forward to zoom in and move the mouse back to zoom out. 

Now it is time to test the various PTZ commands. 

Instructions, PTZ in Ethiris Client 

1. Bring up the new PTZ camera in a live view in Ethiris Client. 

2. Click anywhere in the picture so that the camera view receives 
focus (green rectangle around the camera view) if it does not 
already have focus. 

3. Move the mouse pointer. Verify that the mouse pointer icon 
changes based on where in the picture it is. 

4. Click and hold down the left mouse button to the right of the 
center of the picture (the mouse pointer is a right arrow). Verify 
that the camera moves to the right as long as the mouse button is 
pressed. 

5. While still pressing the left mouse button, move the mouse 
pointer to the left of the center. Verify that the camera changes 
direction. 

6. Try moving the mouse pointer around while still pressing the left 
mouse button. Notice that the camera moves faster the longer 
from the center, the mouse pointer is. When holding the mouse 
pointer near the center of the picture (mouse pointer is an arrow 
cross), the camera stops moving. 
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7. Release the mouse button to stop the camera. 

8. Now, click somewhere in the picture with the center mouse 
button. Verify that the picture is centered on the clicked point. 

9. Try to zoom with the scroll wheel. Scroll forward to zoom in and 
scroll backward to zoom out. 

10. Switch to digital PTZ mode by clicking the Digital PTZ in the popup 
menu. 

11. Try out the different PTZ commands a little and verify that they 
only affect the frame digitally. 

12. Switch back to optical PTZ mode. 

We have now learned how to control a PTZ camera manually from the client. 
The next step is to learn how to control the camera automatically. To be able to 
control the camera automatically, we have to define Preset Positions. 

Instructions, Creating Preset Positions 

Preset positions are named optical PTZ positions for a camera. Many preset 
positions can be created for each camera. 

1. Start Ethiris Admin. 

2. In the Ethiris Server’s configuration tree, locate the PTZ camera 
P5534 and click the + sign to the left of the camera name to 
expand the tree. Click the + sign to the left of the PTZ node and 
finally double-click the Preset Positions node. 

3. Using the commands you learned in the previous section, move 
the camera to the preferred position. 

4. To save the position under a name: Click the Add a new Preset 
position button. When the new position is created, the current 
PTZ-position is read from the camera and is automatically copied 
to the columns Pan, Tilt, and Zoom. 

 
Figure 2.123 Add a new Preset position. 

5. Enter a descriptive name in the Name column, for example, City. 
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6. If you want to alter the coordinates for a position after it is 
created, you can simply move the camera to the desired position, 
select the desired preset position in the list and then click the Use 
current position button. See the red ring in Figure 2.124. 

 
Figure 2.124 Use the current position from the camera. 

7. Add another 2-3 positions. When you are happy, click the Save 
icon in Ethiris Admin’s toolbar to send the new configuration to 
Ethiris Server. 

We can enable the new preset positions manually from Ethiris client. 

1. Start Ethiris Client if you have not already done so. 

2. Select a live view containing the PTZ camera. 

3. Right-click anywhere in the camera picture to open the menu. 
Move the mouse pointer to the menu item, Go to Preset. All the 
preset positions that you defined earlier are now displayed. It may 
look as in Figure 2.125. 

4. Try out a few different positions from the client. 
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Figure 2.125 Example of a selection of preset positions in Ethiris Client. 

Instructions, Controlling the PTZ Camera Automatically 

We will now introduce a little automation.  

We will use the pushbutton that is connected to the video server and we will 
use motion detection to move the PTZ camera to two different pre-set 
positions. 

1. In Ethiris Admin, bring up the Script panel. For clarity, we have 
removed all previous scripts. To do so, simply select all scripts and 
press the Delete button. 

2. In the Variable Browse panel, select one of the preset positions 
and double-click the Preset signal in the lower pane. See Figure 
2.126. The signal is copied into the script. 

 
Figure 2.126 A pre-set position has been selected. 

3. Add an equals sign “ = “ to the end of the line. 
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4. In the Variable Browse panel, locate and select the camera P5534. 
In the lower pane, double-click the Input1 signal. Add a semicolon 
“;” to the end of the line. 
It may now look like 
 
P5534.PTZ.City.Preset = P5534.Input1; 

5. Now repeat the above for one of the other Preset signals, but with 
the camera Door’s Motion Detector as the condition instead. 

 
Figure 2.127 A couple of expressions have been entered to move the PTZ camera to 
different preset positions. 

6. Ethiris needs information about status changes on digital inputs 
from cameras and/or video encoders. To enable this feature, you 
need to check the I/O box for P5534, see Figure 2.128. 

7. When you have linked the required preset output signals to 
suitable input signals, click Save icon in the Ethiris Admin toolbar 
to send the changes to Ethiris Server. 

 
Figure 2.128 Check the I/O box to read digital inputs in Ethiris. 
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Now try to enable the various input signals to see that the camera moves 
between the different preset positions correctly. 

 

Remember that different input signals can be combined to achieve the desired 
effect. A common example involves adding a schedule signal with && to enable 
the output only during specific times. 

In the next example, we will use our preset positions to create a Guard Tour list. 

Instructions, Creating a PTZ Guard Tour 

You can create many guard tours for each PTZ camera. Each list automatically 
generates two output signals, one called Sequential that is used to run the tour 
according to the list order, and one called Random that is used to tour between 
the preset positions in the list in random order. 

1. Start Ethiris Admin. 

2. In the Ethiris Server’s configuration, locate the PTZ camera P5534 
and click the + sign to the left of the camera name to expand the 
tree. Click the + sign to the left of the PTZ node and finally double-
click the Guard Tours node in the treeview. 

3. Click the Add a new Guard Tour button at the top left of the panel. 

4. Enter PTZ Tour in the Tour Name column. 

5. In the treeview, a new node appears under the Guard Tours node. 
Double-click this new PTZ Tour node to open the Guard Tour 
panel. 
 
To the right in the panel, there is a list with the available preset 
positions. See Figure 2.129. Above this list is a list with the 
selected presets that shall comprise the Guard Tour. This second 
list is empty in the example below. Hence the angry red color that 
indicates that the configuration is not complete. No point in 
having an empty tour! 
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Figure 2.129 The list with available Preset positions. 

6. Double-click desired pre-sets to select them into the Guard Tour 
list. 
 
You can select the same position several times. The current list is 
displayed in the top list. 
 
Delete positions by selecting the corresponding row in the list and 
then click the Delete button. 

7. If you want to have time other than 10 seconds in any of the 
positions, simply change the value directly in the list. An example 
of a Guard Tour is Figure 2.130. 
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Figure 2.130 A Guard Tour list has been created. 

8. Click the Save icon in the Ethiris Admin toolbar to send the changes 
to the Ethiris server. 

To test our new tour, we will add a function button to the client to activate the 
tour. 

1. In the client configuration’s tree in Ethiris Admin, right-click on the 
Section One section under the Views node and select  
New->Button->I/O in the popup menu. 

2. Enter Tour as name directly in the treeview. 

3. Double-click the new node Tour in the treeview to open the 
corresponding panel. 

4. Browse IO-signals and select the P5534.PTZ.PTZ_Tour.Sequential 
signal in the list. It may look as in Figure 2.131. 

5. Finally, click the Save button in the Ethiris Admin toolbar to save 
the new client configuration. 

6. Start Ethiris Client if not already started. 

7. View the camera P5534 live so that you see video from it. 

8. Press the new Tour button so that it is depressed. It may look as in 
Figure 2.132. The PTZ camera will now start its tour and keep 
going until you release the Tour button again. 
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Figure 2.131 Variables have been selected for the new button. 

 
Figure 2.132 The tour has been enabled via the button in the client. 

What have you learned? 

In task 11, you have learned how to use and configure various PTZ functions in 
Ethiris.  

In the next task, we will learn how to export recorded video. 
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Task 12, Exporting video 

In this exercise, we will learn how to export recorded video from Ethiris server 
to an AVI file or to multiple JPG images. 

Video can be recorded in Ethiris in two different ways. These are event 
recording or continuous recording. Regardless of the type of recording, the 
video is played back in the video player in Ethiris Client. 

Recorded video can be exported from the Player in several different ways. We 
will go through a couple of examples in this exercise. 

Instructions, Exporting Event Video 

We will start by exporting video that has been recorded by event recording. In 
an earlier exercise, we set up an event-based recording for the camera Door 
when we have motion in front of the camera in accordance with the motion 
detector Motion Detector. 

1. In Ethiris Client, select the Events panel.  

2. Search for the recording you want in the events list and upload the 
video to the video player by double-clicking the event line. As a 
default, events for the latest hour are displayed in the list. Click 
the Select time button for setting another time span, see below. 

 
Figure 2.133 Click the Select time button to change the time span in the Events list. 

3. When double-clicking an event associated with a camera, the 
Player is automatically loaded with the associated camera(s) and 
the time corresponding to the event time. Right-click the red color 
in the timeline where the ruler is and select Export recording… in 
the popup menu. See Figure 2.134. 
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Figure 2.134 Right-click the event recording in the timeline to export video. 

4. The Export dialog appears. The Start and End time is pre-selected, 
matching the event you clicked. The camera Door is also pre-
selected. In this case, we will choose to export to single jpg 
frames. So select JPEG pictures in the Export format dropdown list. 
A few new input fields now appear. 

5. Enter Test in the Prefix box. End with a space. 

6. Enter Ethiris in the Postfix box. Start with a space.  

7. Click the browse button to the right of the Directory box to select a 
folder in which to save the frames. 

8. It is possible to "burn-in" the camera name, date, and time into the 
exported pictures. Tick the corresponding checkboxes Camera 
name in exported frames and Timestamp in exported frames if you 
want this information in the pictures. 

9. When you are happy with the settings, it may look as in Figure 
2.135. Click the Start button to start the export of frames. 

In our example, 119 jpg images are created in the selected folder. To view the 
images, you can use any image viewer software that can handle JPEG images, 
for example, Windows Preview directly in Explorer. 
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Figure 2.135 The settings are ready for export from the video player. 

In the next example, we will export a slightly larger number of frames from 
continuously recorded material. In a previous exercise, we set the camera Door 
so that it continuously records frames at 2 frames per second. Ensure that these 
recording settings are still active. 

Instructions, Exporting Video in general 

In this exercise, we assume that there is continuously recorded material on the 
server hard drive. 

1. In Ethiris Client, select the Player panel. Find some relevant video 
for one or several cameras. 

 Export selection button 2. Click the Export selection button to the right in the Player toolbar. 
The export dialog now opens. Notice that all cameras that are 
selected in the Player also are preselected in the export dialog, 
and the preselected time matches the start and end time of the 
timeline. If you want, you can change the time span. 

3. This time we will export to an AVI file. Click the browse button to 
the right of the File name box. Select a suitable folder, for 
example, the one you used for the jpg images. Enter Ethiris in the 
File name box in the file name dialog. 

4. Click the Save button to select the folder and file name. The search 
path and file name are now copied to the File name box in the 
export dialog. 

5. When all selections have been made for export, click the Start 
button.  
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6. When the first frame is to be written to the AVI file, a dialog 
appears for you to select the Codec. In some versions of Windows, 
the list of available codecs is not visible if you click the arrow 
button by the list. However, it is possible to scroll with the up 
arrow key. Select a suitable Codec, for example, Microsoft Video 1. 
It is also possible to select the compression quality. Then click the 
OK button. The export job is added to the Export Job list. See 
Figure 2.136. More exports can be added, and they are executed 
one by one and eventually disappear from the job list as they are 
executed. 

 

 
Figure 2.136 Export jobs are added to the Export Job list. 

Double-click the AVI file in Explorer to run it in Windows Media Player. 

What have you learned? 

In task 12, you have learned how to export video from recorded material in 
Ethiris. 

In the next task, we will learn how to add control objects to a camera view. 



Getting Started Getting started with Ethiris  

Task 12, Exporting video   
 

2:122 

 



Getting started with Ethiris Getting Started 

 Task 13, Control objects  
 

 2:123  

Task 13, Control objects 

In a camera view, you can insert control objects of six different types. 

Pushbuttons – These are used to set digital (Boolean) output signals or internal 
variables in the Ethiris server. 

LEDs – These are used to indicate the status of a digital signal in the Ethiris 
server. 

Cameras – These are used to symbolize a camera. Clicking the camera symbol 
produces live video from the corresponding camera in a hotspot camera view. 

Texts – These are used to present text or values other than digital, e.g., a 
counter value or a temperature. 

Image - These are used to present smaller static images on top of a background 
image or a camera view. 

Door - These are used to present status for a door handled by an Access 
Controller in Ethiris Server. 

In the first part of this exercise, we will create a new client view Map. This client 
view is a 2*2 view in which we will insert a background image in the bottom 
right camera view. The image may be a site plan or some type of map. 

We will then insert small pushbuttons in the frame, each of which will move the 
PTZ camera to a pre-set position. 

Instructions, Creating Pushbuttons in a Camera View 

1. In Ethiris Admin, right-click Section One and select New->View in 
the popup menu. 

2. Name the view Map and create a 2x2 layout of camera views. 

3. In the layout editor, select the camera view at the top left so that it 
becomes grey. 

4. Right-click on the camera view and select Type->Background 
picture in the popup menu. 

5. Select a suitable background image by browsing for the image. 
 
NOTE! The image may be of type bmp, jpg, gif, or png. 

6. Right-click on the camera view again and select Controls… in the 
popup menu. A control editor now opens in which the selected 
background image is displayed. If there is not enough room on the 
screen, it is scaled down to a smaller size. 

7. At the top left of the control editor is a toolbar with buttons for the 
six different control objects. Click the Add Button button at the far 
left. A small button is created and added to the background image 
at the top left corner. 

 
Figure 2.137 The Add Button button in the control editor toolbar. 

8. You can move the button by dragging it with the left mouse 
button. Place the button where you want it. 
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9. Right-click the button and select the Properties… menu item. A 
dialog for setting the button’s properties is now displayed. 

Enter a & sign before 
the letter so you can enable 
the button from the keyboard 
with Alt+<Letter> 

10. In the Text box, enter a letter or figure that symbolizes one of the 
pre-set positions for the PTZ camera, for example, C for City. 

11. Leave the Toggle button unchecked. In this case, we just want to 
have a short signal that enables the preset position. 

12. Leave Image empty and leave Size as User defined. 

13. Click the browse button to the right in the Variable box. A dialog is 
now displayed for selecting the variable in the Ethiris server. 

14. Search for a suitable preset position, select the Preset signal, and 
click OK. The button properties dialog may look roughly like Figure 
2.138. 

 
Figure 2.138 Dialog for the button properties. 

15. Repeat points 7 – 14 to add more buttons. The end result may look 
as in Figure 2.139. 
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Figure 2.139 Four buttons have been created, one in each corner. 

16. Click the OK button in the control editor to save the new 
pushbuttons. 

17. To be able to see what happens when pushing the buttons on the 
map, add the PTZ camera to one of the three available camera 
views. Now, the layout may look like Figure 2.140. 

 
Figure 2.140 Layout is now complete. 

18. Finally, click the Save button in the Ethiris Admin toolbar to save 
the changes to the client configuration file. 

19. Start Ethiris Client and test the buttons. It may look as in Figure 
2.141. 

NOTE! In all likelihood, the background image will need to be scaled. The 
pushbuttons, as default, retain their original size and are not scaled with the 
image. However, the default behavior is that the positions of the buttons are 
scaled with the image. This may mean that parts of a button may be outside the 
image if they are near the edge of an image that has been reduced. In that case, 
the button is not displayed. You then need to adjust the position of the button 
or deselect the Fixed size checkbox in the button properties dialog. 
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Figure 2.141 Pushbuttons on the background image in Live mode. 

In the next part of the exercise, we will create two LEDs and insert them in the 
background image to indicate the status of two of the signals in the Ethiris 
server. 

One LED will indicate when the tour of the PTZ camera is active, and the other 
LED will indicate when the pushbutton that we connected to the P5534 is 
depressed. 

Instructions, Creating LEDs in a Camera View 

1. In Ethiris Admin, bring up the control editor for the map again. 

2. This time, click the Add LED button. In the same way as a 
pushbutton, the object is created on top of the background image 
at the top left. 

 
Figure 2.142 The Add LED button in the control editor toolbar. 

3. Drag the LED to where you want it in the image. 

4. Right-click the LED and select Properties… in the menu. A dialog for 
setting the properties of the LED is displayed. 

5. Select the On image Red. The on image determines the image that 
is displayed when the underlying signal is 1/True. 

6. Let the Off image be Grey. The off image determines the image to 
be displayed when the underlying signal is 0/False. 

7. Click the browse button to the right in the Variable box to display 
the dialog for selecting the variable in the Ethiris server. 

8. Search for the variable P5534.PTZ.PTZ_Tour.Sequential. Select this 
and click the OK button. The dialog for LED properties may now 
look as in Figure 2.143. 
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Figure 2.143 Dialog for properties for an LED. 

9. Click the OK button and verify that the LED is now displayed in red. 
The current On image is used to draw the LEDs in the control 
editor. 

10. Repeat points 2-9 to add another LED, this time connected to the 
signal P5534.Input1. 

11. The control editor may now look as in Figure 2.144. Click the OK 
button to save the new LEDs. 

12. Click the Save button in the Ethiris Admin toolbar to update the 
client configuration. 

13. Check the result in Ethiris Client. 

Click the Tour function button to verify that the associated LED lights up red 
while the Tour button is depressed. Test the pushbutton that is connected to 
the P5534 as well. 
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Figure 2.144 Two LEDs have been created in the control editor. 

Now we will create a few camera symbols in the background image. 

A camera symbol represents a camera and, if you click the camera symbol, you 
can display live video from the camera in a hotspot camera view. 

To introduce a new feature in Ethiris, we will create a Popup Window and a 
view with no corresponding view button. The view will, when activated, be 
opened in the popup window. 

Instructions, Creating a Popup Window 

1. In the client configuration’s treeview in Ethiris Admin, double-click 
the node Popup Windows. 

2. In the Popup Windows panel, add a new item by clicking the Add 
new popup window button. 

3. Enter the name HotPop in the Name column. See Figure 2.145. 

 
Figure 2.145 A new Popup window with the name HotPop is created. 

4. The settings for the popup window are default settings that are 
used the first time the window is opened. When the window is 
open, the user can move and resize it. The next time it is opened, 
the latest position and size are used. 
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Alright, now we have a popup window called HotPop. The next step is to create 
a new view with a hotspot camera view. 

Instructions, Creating a view with no view button 

1. In the client configuration’s treeview in Ethiris Admin, right-click 
the node Section One and select New->View in the popup menu. 

2. Enter the name Hot directly in the new node in the treeview. 

3. Double-click the new node Hot to open the panel. 

4. Check the checkbox Hide View in Client. The effect of this is that 
there will be no view button for the view in Ethiris Client. 

5. Check the checkbox Activate on Hotspot Camera activation. This 
means that the view will automatically be activated when a 
hotspot camera is activated that is defined in a Hotspot camera 
view in the layout of the view. 

6. Select Popup window: HotPop in the Show in list. The panel looks 
like Figure 2.146. 

 
Figure 2.146 Properties for a view with no view button. 

7. Double-click the Layout node under the new view Hot in the 
treeview. 

8. In the black camera view, right-click and select Type->Hotspot in 
the popup menu. See Figure 2.147. 
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Figure 2.147 Select Type Hotspot in the camera view. 

9. In the rightmost panel, check the checkbox Hotspot is globally 
sensitive. This means that the view will react when a hotspot 
camera is activated (clicked on) in another view. 

10. Check the Click column for every camera that you want to show 
live video from when the corresponding camera symbol is clicked 
on. The panel may look like Figure 2.148. 

 
Figure 2.148 The view is globally sensitive for Hotspot activation, and all cameras are 
selected as potential hotspot cameras. 

Now it’s time to add some camera symbols to the map we added earlier. 
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Instructions, Creating Camera Symbols in a Camera 
View 

1. Bring up the Control editor for the Map camera view in the view 
Map. 

2. Click the Add camera button. A camera symbol is added to the 
control editor in the upper left corner. 

3. Drag the camera symbol to where you want it in the image. 

4. Right-click the camera and select Properties… in the menu. A 
dialog for setting the properties of the camera is displayed. 

5. Angle defines how the camera symbol will be displayed. Drag the 
slider for the angle you want. 

6. Select the Camera Door. This is the camera that the camera symbol 
will represent. 

7. Leave the other settings for now. Click the OK button when you are 
happy with the settings. 

8. Repeat points 2-7 to add more camera symbols. 

 

 
Figure 2.149 Dialog for setting properties for a camera symbol. 

9. An example of how this may look is displayed in Figure 2.150. Click 
the OK button in the control editor when you are happy with your 
cameras. 
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Figure 2.150 Cameras have been added to the control editor. 

10. Click the Save button in the Ethiris Admin toolbar to save the 
changes to the client configuration file. 

11. Switch to Ethiris Client to test the new camera symbols. Click them 
and verify that live video is displayed in the intended popup 
camera view. 

 

What have you learned? 

In task 13, you have learned about various maneuver objects that can be added 
to camera views in Ethiris Client, such as buttons, LEDs, cameras, and labels. 

In the next task, we will learn how to create custom events for tracking various 
events in the system. 
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Task 14, Custom events 

In Ethiris, some System Events are automatically created, such as a Record Event 
for each camera in the configuration. When an event is triggered, a log item is 
created and can be viewed in the Events panel in Ethiris Client. E.g., whenever 
an event recording starts for a camera, this event is logged in the Events log and 
can be viewed in Ethiris Client. 

Besides the automatically generated system events, you can create custom 
events. These, too, are logged on activation and can be used for tracking 
various events in the system. 

In this section, we will create a custom event pretending that a door to a bank 
vault is connected to a digital input in such a way that every time the vault is 
opened, the digital input is activated. We will use the digital input on the Axis 
P5534 camera we have used in previous exercises. 

Instructions, Creating a custom event 

1. In Ethiris Admin in the server configuration part of the treeview, 
expand the Logic node and then double-click the Events node to 
open the Events panel. 

2. In the Events panel, click the New Event button. A new row is 
created in the list of custom events. 

3. In the Name column, enter a name for the new event, e g 
VaultOpen. 

4. Enter a Text, e.g., The bank vault is open. This text will be displayed 
in the Event log in Ethiris Client when the event has been 
triggered. 

5. Leave the checkbox Momentaneous checked. This means that the 
event can be automatically inactive. E.g., our VaultOpen event, 
when the digital input is set to 0, the event is inactivated again. 
The vault is no longer open. If the event were named 
VaultOpened, it would be another matter. Even when the vault is 
closed, it was opened before, and that event cannot be undone. 

6. In the treeview, expand the Events node and double-click the new 
VaultOpen node to open the VaultOpen event panel. 

7. Check both the P5534 and the Door camera in the Associated 
cameras list. See Figure 2.151. Associating one or several cameras 
for an event opens the possibility to automatically load the Player 
with appropriate cameras when double-clicking the corresponding 
event in the event log. 
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Figure 2.151 Cameras have been associated with the event. 

OK, now we have created a custom event that is associated with 2 cameras. The 
next step is to configure when the event should be triggered/activated. 
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Instructions, Activating an event via script 

1. In Ethiris Admin in the server configuration part of the treeview, 
expand the Logic node and then double-click the Script node to 
open the Script panel. 

2. In the Variable Browser, a new node, Event, has appeared. Select 
the new Events node in the Variable Browser. 

3. In the lower pane in the Variable Browser, the event VaultOpen is 
displayed. Double-click the VaultOpen item to copy the variable to 
the script editor. 

4. Directly after the text VaultOpen in the script editor,  

enter “ = “. 

5. In the Variable Browser, click the P5534 camera and in the lower 
pane, double-click Input1 to copy the Input1 variable to the script 

editor. Finish the line by entering “;”. The script should resemble 
the one in Figure 2.152. 

 
Figure 2.152 Script for activating the VaultOpen event. 

The script above means that every time Input1 is activated, the event is also 
activated, and a new log item is entered into the event log. 

Naturally, any condition possible by the script can be used to activate an event, 
such as combining several signals in the system. 

NOTE! As Start recording on associated cameras when activated is checked in 
event definition, both cameras will automatically start recording when the 
event is activated and continue record as long as the event is active. 

 

Alright, now we are ready to test the new event. You need some way of 
activating the digital input on the camera. I will use a push-button myself for 
simulating the bank vault is open. 
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Instructions, Testing the event 

1. Start the Ethiris Client. 

2. Select the Events panel. 

3. Activate the Input1 signal. Immediately, a new event appears in 
the event log. See Figure 2.153. 

 
Figure 2.153 A new event appears in the event log. 

4. Double-click the event to automatically load the Player with these 
two cameras and the correct time. See Figure 2.154. 

 
Figure 2.154 The Player panel is automatically loaded with the associated cameras and 
the event time. 
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What have you learned? 

In task 14, you have learned how to create your own specific custom events for 
logging important events in the system. You also have learned how to quickly 
retrieve video associated with the event by double-clicking the event in the 
Events panel in Ethiris Client. 

In the next task, we will learn how to create custom alarms and alarm groups. 
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Task 15, Custom alarms 

In the previous section, we had a look at custom events. In this section, we will 
have a closer look at alarms. Just as in the case with events, there are quite a 
few system alarms that are automatically created by Ethiris. Examples of system 
alarms include communication error for each camera, various problems with 
storage devices, and script runtime error. 

The difference between an alarm and an event is that an alarm must be 
acknowledged. The idea is that alarms are more serious than events. When an 
alarm is active, this is indicated in Ethiris Client by a flashing warning icon that is 
nearly impossible to miss. 

The alarm list in Ethiris Client displays the status of active or unacknowledged 
alarms, whereas the event list displays a history of events that have occurred in 
the system. When everything is as it should be, the alarm list is empty. 

However, every status change for every alarm is logged in the event log. E.g., 
when an alarm goes active, a log item is created in the event log. When the 
alarm is acknowledged, there is another log item in the event log. And finally, 
when the alarm goes inactive, this is logged in the event log by a third log item. 

Every alarm belongs to a specific Alarm group. One alarm group, System Failure, 
is automatically created by Ethiris, and all automatically created system alarms 
belong to this group. 

Besides the automatically generated system alarms and alarm groups, you can 
create your own custom alarms and custom alarm groups. These behave just 
like their system counterparts. 

In this section, we will create a custom alarm group and a custom alarm. We 
will continue with the bank vault example and activate the alarm if the vault is 
open to long. So, we continue to use the digital input from the Axis P5534 
camera. You may, of course, use another camera model or another kind of 
signal for the same purpose. 

If you don’t have access to any physical digital input, you may create an internal 
variable, connect it to a button in Ethiris Client and use the button for triggering 
the VaultOpen signal. 
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Instructions, Creating an alarm group 

1. In Ethiris Admin in the server configuration part of the treeview, 
expand the Logic node and then double-click the Alarm Groups 
node to open the Alarm Groups panel. 

2. Click the New Alarm Group button. A new row is added to the list 
of alarm groups. 

3. Enter a name in the Name column, e.g., “Vault alarms”. 

4. Select a Display Color different from red, e.g., blue. This 
background color will be used in the alarm list to make it easier to 
differentiate various alarms. 
 
The Alarm Groups panel should look like Figure 2.155. 

 
Figure 2.155 A new Alarm group, Vault alarms, is created. 

OK, the next step is to create the alarm. 
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Instructions, Creating an alarm 

1. In Ethiris Admin in the server configuration part of the treeview, 
expand the Logic node and then double-click the Alarms node to 
open the Alarms panel. 

2. Click the Add new Alarm button. A new row is created in the list of 
alarms. 

3. In the Name column, enter a name for the alarm, e.g., 
VaultOpenTooLong. 

4. In the Text column, enter a suitable text, e.g., The vault has been 
open more than 1 minute. 

5. Leave Severity and Acknowledge as default. 

6. In the Alarm Group column, select the group Vault alarms. It 
should look like Figure 2.156. 

 
Figure 2.156 A new Alarm, VaultOpenTooLong, is created. 

7. To be able to associate cameras to the alarm, you have to open the 
panel for the alarm as opposed to the whole list of all alarms. 
Expand the node Alarms in the treeview and double-click the 
VaultOpenTooLong node. 

8. Check desired cameras in the Associated cameras list. In Figure 
2.157, the P5534 is checked. 
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Figure 2.157 The P5534 camera is associated with the alarm. 

At this point, we have defined both a new alarm group for all our vault alarms, 
and we have also defined a specific alarm for when the vault has been open too 
long. 

Now we come to a somewhat tricky part, the activation of the alarm. As a 
bonus, you get to learn how to use timers in Ethiris script. 

In this example, we assume that the vault is allowed to be open no more than 1 
minute. If the time is exceeded, the alarm should be activated. 

To make the script code more clear, it’s a good practice to use comments to 
describe various parts of the script. Comments are not executed by the script 
engine and can contain any text. There are two types of comments; Single line 
comments and a Block of comments. Single line comments start with two 

slashes, “//”. Everything after the slashes on the same line is considered a 

comment. A block of comments is everything between “/*” and “*/”. Such a 
comment can span multiple lines. In the script editor, comments are displayed 
in green color. 

The script in Ethiris is executed over and over again in a cyclic manner. The 
default execution interval is 150 ms. This fact demands specific precautions. 
The idea in our example is to start a timer as soon as the input signal from the 
camera goes high. But since the script is executed cyclically, we have to make 
sure that the timer is only started once, on the edge of the input signal getting 
high. For this purpose, we use a local variable to keep track of the current state 
of the input signal. We also exploit the fact that the script is executed from top 
to bottom, line by line. 

Enough talk, let’s get going with the activation of our alarm 
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Instructions, Activating the alarm 

1. In Ethiris Admin in the server configuration part of the treeview, 
expand the Logic node and then double-click the Script node to 
open the Script editor panel. There are already some existing lines 
of script. Keep these lines intact and just enter a few new lines 
after the last line in the script. 

2. This time we need to declare some local variables in the script, 
which we have to write manually. We will also make use of 
comments. Enter the following lines: 
 
// Declare a timer for detecting vault open 

// 1 minute (60 000 ms) 

var vaultTimer; 

 

// Declare a variable for detecting edge of 

// input going high 

// Otherwise the timer restarts every 150 ms 

var inputEdge; 

3. Now we will, if necessary, create the timer object and start the 
timer once when the input goes high. We will use an if-statement 

for this purpose. Note the exclamation mark “!”, it inverts the 
signal. In this case, the code in the if-block executes if the input 
signal on the camera is active (high), and the variable inputEdge is 
not active (low). Enter the following lines last in the script: 
 
// Start timer on edge of Input1 

if (P5534.Input1 && !inputEdge) 

{ 

   // Create timer if not done already 

   if (vaultTimer == undefined) 

   { 

      vaultTimer = new Timer(); 

   } 

 

   // Start timer with 1 minute timeout 

   vaultTimer.start(60000); 

} 
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4. In the next, if-block, we will check if the timer has entered timeout. 
If so, the alarm will be activated. Enter the following lines last in 
the script: 
 
// If the vault is open… 

if (P5534.Input1) 

{ 

   // … and we have timeout 

   if (vaultTimer.timeout()) 

   { 

      // Activate alarm, will also start 

      // recording  

      VaultOpenTooLong = true; 

   } 

} 

else 

// Input1 is low -> Reset alarm &  

// stop recording 

{ 

   VaultOpenTooLong = false; 

} 

5. The final step is to update the edge variable with the current status 
of the input signal. Enter the following lines: 
 
// Update status of input edge 

inputEdge = P5534.Input1; 

The script looks like the one in Figure 2.158. 

 
Figure 2.158 Script for activation of the alarm is entered. 
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Then, finally, it is time to test the new alarm. Turn to the next page for 
instructions. 

Instructions, Testing the alarm 

1. Start Ethiris Client. You can select any panel (Live, Events, Alarms or 
Player).  Activate the input signal on the camera. After 1 minute, 
the alarm icon starts flashing in the upper right corner of Ethiris 
Client.  

2. Select the Alarms panel. An alarm has appeared, see Figure 2.159. 

 
Figure 2.159 Active alarm in the alarm list and flashing alarm icon in Ethiris Client. 

3. Select the alarm by clicking somewhere on the alarm item in the 
alarm list. Click the Acknowledge Alarm button (green tick) to 
acknowledge the alarm. The alarm icon is now displayed without 
flashing. 

4. Reset the input signal. The alarm disappears from the alarm list, 
and the alarm icon also disappears. 

5. Select the Events panel. In the event list, you can see the history of 
all status changes for alarms. In Figure 2.160, you can see the time 
when the alarm got activated, acknowledged, and finally 
inactivated. 

6. If you want to retrieve video from the associated camera, simply 
double-click an event in the event list. The player panel is 
automatically selected and loaded with video from the associated 
camera(s), and the time ruler is set to the time of the event.  
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Figure 2.160 The Event list logs all status changes for alarms. 

 

What have you learned? 

In task 15, you have learned how to create your own specific custom alarms and 
alarm groups. An alarm is considered an important serious condition in the 
system. An operator will immediately be notified in case of any alarm by the 
flashing alarm icon in Ethiris Client. 

 

You have now completed all the exercises. We hope that you have learned a lot 
about Ethiris. 

For more detailed information about different parts of Ethiris, please read the 
Ethiris Client User´s Guide and Admin - Configuration for Ethiris. 
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3 Explanation of Terms 

AVI 

Audio Video Interleaved. File format for video sequences. Ethiris can export 
frames to such a file, which can then be played in Windows Media Player, for 
example. 

Camera view 

A view that can display frames from a camera. A live view can display up to 64 
camera views simultaneously. 

Client view 

A client view can contain between 1 and 64 camera views. Each client view can 
be linked to a function button that is displayed in the live view. 

COM 

Component Object Model. A binary communication standard from Microsoft 
that can be used in communication between various program components. 
COM is the basis of OPC. 

Command port 

In communication via TCP/IP, the recipient of data must be identified with both 
an IP address and a port number. We call the port number on which an Ethiris 
server listens for commands from clients the command port. By default, this is 
1235. If necessary, the number can be changed in the system configuration for 
each Ethiris server. A port number can assume values between 1 and 65535. 

Continuously recorded frames 

A type of recorded frames that are recorded continuously from a camera at a 
specific time interval between each frame. The video is recorded regardless of 
whether alarm events occur. 

Control panel 

A panel with some function buttons and text information that can be displayed 
at the bottom of a camera view. 

Data store 

The data store is located in Ethiris Server and contains all variables and their 
current state in the system. 
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Document window 

This is a window that is used for presenting the various types of information, 
such as live and recorded video. In Ethiris Client, there are four document 
windows by default. These are Default Live panel, Events panel, Alarms panel, 
and Player panel. 

Default Live panel 

This is the window where live video is displayed by default. However, it is 
possible to create additional live windows as well. 

Floating window 

A floating window has been torn away from the main frame and is floating 
freely. In a floating state, a window can be positioned on another monitor and 
can be resized as desired. 

Function button 

A function button in this context is a button in the live view that, when you click 
it, either selects a predefined layout of camera views or starts recording from 
the camera selected. 

FTP 

File Transfer Protocol. In Ethiris, it is possible for certain camera models to 
specify that on an alarm, the images shall be sent by FTP. In that case, images 
are not sent continuously which is the normal behavior, but images are sent 
only when an alarm is detected in the camera. An event is created in Ethiris just 
as it was a normal event-triggered recording. In this way, you can conserve a lot 
of bandwidth in your system. 

H.264 

A video compression standard built on similar technology as MPEG-4. H.264 is 
also called MPEG-4 part 10. It is even more compact then MPEG-4, about half 
the size for a comparable quality. But on the other hand, it is very demanding 
for the hardware, especially when it comes to high-resolution frames. 

Hotspot 

A type of camera view that displays frames from the camera manually selected 
and/or automatically from a camera linked to a Boolean variable in Ethiris 
Server’s data store. 

I/O 

Input/Output, exist both as digital and analog signals. Several camera models 
have a number of digital inputs and outputs that can be used to connect extern 
equipment to the system. 

IP address 

Each device connected to a computer network has a unique IP address that 
consists of 4 groups of digits. Each group can be 0-255, for example, 
192.168.30.29. 
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License key 

A key that is received from Kentima Solutions after a registration key has been 
submitted. The license key is used to “unlock” Ethiris via the license dialog. 

Live frames 

Video from a camera that is being filmed right now, as opposed to recorded 
frames. 

Main frame 

The main frame is the area in Ethiris Client available for various windows such 
as the Default Live panel, the Player, and tool windows. 

MJPEG 

Motion JPEG, a video compression format where each frame is a separate JPEG 
image.  

MPEG-4 

A video compression format where a complete image (i.e., I-frame) is followed 
by several smaller images depicting the difference compared to the last image 
(P-frames or B-frames). This is a more compact format compared to MJPEG. 

Network camera 

A type of camera that can be directly connected to a network. The camera 
device has a unique IP address. 

OPC 

OLE for Process Control. A communication standard developed within the 
automation industry for communication between different systems. 

Pin 

A tool window can be pinned, which means that it will not slide into the edge 
when it loses focus, but it stays open. 

Preset position 

For a camera with a PTZ function, you can define pre-set positions in Ethiris. A 
pre-set position is a named position with pre-set coordinates for pan, tilt, and 
zoom. A preset position can be activated manually in Ethiris client by an 
operator, but also automatically through a script in the Ethiris server. PTZ tours 
are built up by a list of preset positions. 

Product code 

A key following each Ethiris license. The key shall be entered at installation 
time. The Ethiris server requires a product code at installation. 

Protocol 

The selected protocol specifies what method to use when Ethiris requests 
images from a camera. Today the choices are MJPEG, MPEG-4, H.264, and 
H.265. 
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PTZ 

Pan, Tilt & Zoom. The standard designation for cameras with these functions. 

Receive port 

When communicating over RTP, the images are sent from the camera to a 
specific port number on the computer where Ethiris server runs. If you don't 
specifically set a port number, Ethiris will randomly select an available port 
number. In some cases, e.g., if you have to open the port in a firewall, you want 
to specify this port number. 

Registration key 

The key that uniquely identifies an instance of a program. The key is generated 
by clicking the Register button in the license dialog. This key must be sent to 
Kentima Solutions AB to unlock Ethiris. 

Round 

A type of camera view in which a list of cameras is created for automatic 
switching between cameras at a specific time interval. 

RTP 

Real-Time Protocol. The video transport protocol used on TCP/IP networks, 
most common for MPEG4 and H264 video. 

Scale mode 

It indicates how the frame in a camera view is to be displayed. The options are: 
Keep Aspect Ratio, Fill Display area, and Original size. The default scale mode is 
Keep Aspect Ratio, where the image is as large as possible without distorting 
the proportions (aspect ratio). 

Section 

A part of the system with its own set of view buttons and function buttons. 
Each section is represented by an item in Sections Explorer. A Section can 
consist of other sections making it possible to build hierarchies. 

Tab group 

Both Document windows and Tool windows can be grouped together and 
become tabs in a group. In this state, only one window at a time in the group 
can be visible. Click a tab to make the corresponding window visible. 

TCP/IP 

Transmission Control Protocol/Internet Protocol. 

Test license 

When Ethiris is installed, a test license is received with which you can test the 
product free of charge. 
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Timelines 

Ethiris timelines are used in the Player for graphically visualize when there is 
recorded video for various cameras. Event recordings are indicated with red 
color, and continuous recordings are indicated with blue color. 

Tool window 

A Tool window is used for supplying the user with various tools such as a list of 
available sections, views, or cameras. In Ethiris Client, there are four Tool 
windows. These are Sections Explorer, Views Explorer, Cameras, and Export 
Jobs. 

Trigger level 

The level of motion required in a frame for it to be interpreted as a motion 
alarm. Indicated in % of pixels with motion in relation to all pixels monitored in 
the frame. 

Unpin 

When you unpin a tool window, it will slide into the edge of the main frame 
when it loses focus, leaving visible only a tag with the name of the window. 

User interface 

The elements in a computer program with which a user works when using the 
program. What is visible on the screen, such as forms, dialogs, etc. 

User operation 

There are 30 various user operations for which you can require authorization in 
Ethiris. Examples of user operations are "View live video" and "Update server 
configuration". 

Video encoder 

A device that can be directly connected to a computer network. Its purpose is 
to convert one or more video signals to a format that can be sent on the 
network, for example, MJPEG. 

Video request port 

When communicating over RTP, the camera might require video requests on a 
port different from the normal communication port over TCP. In that case, you 
can specify the correct video request port. The default value for this port is 
automatically selected by Ethiris based on the selected camera model. 

Viewing area 

The area in the live view that is used to display frames from different cameras, 
i.e., excluding menu and function buttons. 

 





Getting started with Ethiris Index 

   
 

 4:1  

4 Index 

A 

Alarm 
Acknowledge 2:145 
Create 2:141 
Custom 2:139 

Alarm group 
Create 2:140 

Associated cameras 2:133, 2:141 

B 

Background filtering 2:46 
Number of frames 2:46 

C 

Camera 
Adding 2:17 
Associated 2:133, 2:141 
Disable 2:87 

Client configuration 
Open 2:30 

Continuous recording 2:41 
Automatic deletion 2:41, 2:42 
Playback 2:43 

Control objects 2:123 
Camera 2:131 
LED 2:126 
Pushbutton 2:123 

Control panel 2:102 
Custom alarm 

Create 2:141 

D 

Deleting video 
Automatically 2:61 

Deviations 2:56 

E 

Email 
Getting started 2:65 
Settings in Ethiris server 2:65 

Ethiris Server 

Connecting 2:16 
Event 

Activate via script 2:135 
Events 

Custom 2:133 
Create 2:133 

Exporting video 2:118 

F 

Filter events 2:39 
Filter time 2:46 
Firewall 2:16 
FTP 2:76 

G 

Guard tour 2:113 

K 

Keyboard shortcut 2:124 

L 

License 
Levels 2:9 
Registration 2:8 
Temporary 2:1 

License missing 2:1 

M 

Motion detection 
Background filtering 2:46 

Number of frames 2:46 
Defining 2:44 
Filter time 2:46 
Masking 2:45 
Number of frames for triggering 2:46 
Pen size 2:45 
Resolution 2:46 
Sensitivity 2:46 
Trigger level 2:45, 2:46 

P 

Playback speed 2:37 
Popup window 2:128 
Preset position 2:109 
PTZ 2:106 
Purpose 

Ethiris 1:1 
Manual 1:1 

R 

Record video 2:33 
Recording 

Alarms 2:44 
Continuous 2:41 



Index Getting started with Ethiris  

   
 
 

4:2 

Manual 2:33, 2:34 
Viewing video 2:35 

Registration key 2:1 

S 

Scalability 1:2 
Schedule 

Add 2:49 
Add template 2:51 
Live video 2:54 

Script 
Example 2:54, 2:58, 2:70, 2:111, 2:135, 2:143 
Timer 2:142 

Section 

Creating 2:25, 2:107 

Security 2:91, 2:94 
SMS 

Getting started 2:73 
Speed 2:37 

T 

Time ruler 2:37 
Timespan 2:36 
Tracelog 2:100 
Troubleshooting 2:99 

V,W 

Video encoder 
Adding 2:81 
Configure 2:76 

View 

Creating 2:25 

With no view button 2:129 
Windows groups 2:91, 2:92 
Windows users 2:91 

 





Index Getting started with Ethiris  

   
 
 

4:2 

 

 

 


